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Tektronix Supplies and Accessories

Front Panel Toner
Cartridges

Imaging Unit ]
& Main Charge Display

saiiddns

0632-61

Note

Inside the printer, all handles, knobs, and other features that
the user interacts with are blue.

When the front panel prompts you that a supply is low or needs to be
replaced, make sure that you have replacements on hand. To order
supplies and accessories, contact your local dealer or visit the

Tektronix web site:

www.tek.com/Color_Printers/supplies/
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Supplies

33100-33

High Capacity Toner Cartridges

Item Part Number
Cyan 016-1800-00
Magenta 016-1801-00
Yellow 016-1802-00
Black 016-1803-00

Standard Toner Cartridges

Item Part Number
Cyan 016-1804-00
Magenta 016-1805-00
Yellow 016-1806-00
Black 016-1807-00

0236-44

Main Change Grid

Item Part Number
Main Charge Grid 016-1665-00
10 Phaser 750 Color Printer



33100-35

Fuser
Item Part Number
110 volt 016-1839-00
220 volt 016-1840-00

33100-36

Fuser Roll and Cleaning Pad

Item Part Number
Fuser Roll (with Cleaning Pad) 016-1843-00
Fuser Cleaning Pad 116-0329-00

User Guide
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Imaging Unit

Item Part Number

Imaging Unit (Color Imaging Kit) 016-1841-00

0236-43

Transfer Kit

Item Part Number

Transfer Kit 016-1842-00
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Tektronix Professional Printing Paper

Item Size Description Part Number

Premium Color Printing  A/Letter (U. S.) 500 sheets 016-1368-00

Paper 8.5 x 11 in.

Premium Color Printing A4 (Metric Letter) 500 sheets 016-1369-00

Paper 210 x 297 mm

Glossy Coated Paper A/Letter (U. S.) 100 sheets  016-1704-00
8.5 x 11 in.

Glossy Coated Paper A4 (Metric Letter) 100 sheets 016-1705-00
210 x 297 mm

Premium Cover Paper A/Letter (U. S.) 100 sheets 016-1823-00
8.5 x 11 in.

Premium Cover Paper A4 (Metric Letter) 100 sheets 016-1824-00

210 X 297 mm

Tektronix Transparency Film

Item Size Description Part Number

Premium Al/Letter (U. S.) 50 sheets 016-1427-00
8.5 x 11 in.

Premium A4 (Metric Letter) 50 sheets 016-1428-00
210 x 297 mm

Standard Al/Letter (U. S.) 50 sheets 016-1431-00
8.5 x 11 in.

Standard A4 (Metric Letter) 50 sheets 016-1432-00
210 x 297 mm

Tektronix Color Laser Labels
Size Description Part Number

Al/Letter (U. S.)

8.5 x 11 in.

100 sheets / 30 labels per sheet 016-1695-00
1.0 x 2.625 in. labels

Al/Letter (U. S.)

8.5 x 11 in.

100 sheets / 6 labels per sheet

3.33 x 4.0 in. labels

016-1696-00

User Guide

13



Tektronix Color Laser Labels

Size Description Part Number
A4 (Metric Letter) 100 sheets / 14 labels per sheet 016-1688-00
210 x 297 mm 38.1x 99.1 mm labels
A4 (Metric Letter) 100 sheets / 8 labels per sheet  016-1689-00
210 x 297 mm 67.7 x 99.1 mm labels
Paper Trays
Item Paper Capacity Part Number
Al/Letter (U. S.) 250 sheets 436-0282-02
A4 (Metric Letter) 250 sheets 436-0283-02
U. S. Legal 250 sheets 436-0314-02
Transparency Trays
Item Part Number
Al/Letter (U. S.) 436-0284-02
A4 (Metric Letter) 436-0285-02

Printer Station

Features Part Number

m Ergonomic surface height ZCARTA

m Provides storage for supplies

Internal Hard Drive

Feature Part Numbers

m Adds collation Z750HD
m User documentation on disk
m Enhanced Job Accounting

m Enhanced PhaserLink features
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Automatic Duplex/Lower Tray Assembly

Features

Part Number

m Automatic duplex with the Duplex Unit
m Lower Tray Assembly with:

m 1 Paper Tray

m 1 Transparency Tray
m Increased paper-printing capacity

m Increased printing versatility and convenience.

U.S./Standard:
ZDPLX Option 00

Metric: ZDPLX
Option 01

PhaserShare® Token Ring Network Card

Features

Part Number

m Easy to install

m Token Ring connectivity

ZNBTR

Additional memory

Feature

Part Numbers

Improved performance
m 64 Mbytes
m 128 Mbytes

ZMC64
ZMC128

User Guide
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Print Quality Modes

You can select the Print Quality mode in the follow ways:

1. From the software driver. (This always overrides the front panel
setting.)

2. From the printer’s front panel. Press Menu, scroll to Print Quality,
press Menu, and select a Print Quality Mode.

Black and White Converts all colors to black, white, and shades of
gray. Prints at 1200 x 600 dpi.

Fast Color Fastest color print mode. Prints at 600 x 600 dpi
using only the cyan, magenta, and yellow toners;
black is a composite color. Not recommended for
black text.

Standard General-purpose mode for color printing. Prints at
600 x 600 dpi using all four color toners.
Transparencies are always printed in Standard mode
even if another mode is selected.

Enhanced Produces superior text resolution and smooth colors.
Prints at 1200 x 600 dpi.

Premium Produces the highest-quality color prints at 1200 x
1200 dpi. Available only on 750P, 750DP, and the
750DX configurations.
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TekColor~ Color Corrections

You can select the TekColor™ Color Correction mode in the following

ways:

1. From the software driver. (This always overrides the front panel

setting.)

2. From the printer’s front panel. Press Menu, scroll to Print Quality,
press Menu, and select a TekColor™ Color Correction.

Automatic Optimizes colors for each element (text and graphics) on the
page. Best all-purpose selection.

None No color correction applied. Use with printer specific (i.e.,
using the printer’s PANTONE® Color chart) PANTONE®
Colors or when no correction is desired.

Vivid Color  Produces the brightest possible colors. Makes blue colors

appear less purple. Use when printing transparencies.

sRGB Display

Closest match to computer screen colors.

SWOP Press  Specification for Web Offset Publications. Use to match U. S.
press standards.

Euroscale Use to match equivalent Imation Matchprint® proofs.

Press

Commercial  Use to match commercial Imation Matchprint® proofs. Best

Press choice for comps.

DIC Use to match Dai Nippon printing inks on coated paper.

Toyo Use to match commercial Toyo printing inks on coated

paper.

Use Printer
Setting

Uses the selection made at the printer's front panel.
To set a printer default TekColor correction:

m At the READY menu, press Menu.

m Scroll to Print Quality, press Menu.

m Scroll to TekColor Correction, press Menu.

m Scroll to the correction, press OK.

User Guide
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Paper Tips

Paper Tips

Caution

Do not use any media designed for inkjet printers, especially
inkjet coated paper and inkjet transparencies. Inkjet media is
coated with a substance that will damage the fuser. Tektronix
does not furnish warranty service for damage or malfunction
caused by the use of non-Tektronix supplies or consumables.
Always use Tektronix media that has been specially designed
for use with Tektronix Laser Printers.

m  To prevent Jam-Wrong Media errors, load only paper in the PAPER
tray and Tektronix transparencies in the TRANSPARENCY tray or
Multi-Purpose tray.

m  If you have the Automatic Duplex/Lower Tray Assembly:

Insert the Duplex Unit only in the upper (a) slot.

Insert the TRANSPARENCY tray only into the middle (b) tray
slot.

Insert the PAPER tray into the middle (b) or lower () slot.

m  Always use the Multi-Purpose Tray (d) for specialty media.

0236-06

®m  When loading the Multi-Purpose Tray, the front panel
automatically prompts you to select the media type and media

size.

18
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B When you select a media tray by location (Upper, Middle, Lower,
Multi-Purpose Tray), the printer picks from that tray, regardless
of the tray’s media type or size.

B Always keep media in a sealed package to avoid the effects of
humidity, which can affect print quality.

Letterhead

m  For printing letterhead:

m  In the PAPER tray put this material face-down.
m  In the Multi-Purpose Tray put this material face-up.
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Supported page sizes and image area

The printer supports five media sizes, which you select in the Print
screen (using a supported printer driver).

Margins
Media Page size Print area Top/ Sides
Bottom
1 Letter 8.5x 11 in. 8.21 x 10.56 in. .22 in. .14 in.
2 Ad 210 x 297 mm 200 x 287 mm 5 mm 4.8 mm
3 Legal 8.5 x 14 in. 8.2 x13.5 in. .23 in. .14 in.
4 Executive 7.25 x 10.5 in. 6.93 x 10.31 in. .22 in. .15 in.
5 #10 4,13 x 9.5 in. 3.8x9.21in. .16 in. .14 in.
Envelope (104.8 x (96.5 x 233.7 mm) (4.1 mm) (3.6 mm)
241.3 mm)
1 2 3 5

20
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Paper and Transparency Trays

Paper Tray

0632-01

m  250-sheet capacity
m  60-90g/m? (16 -241b.)

m  Use Tektronix Premium Color Printing Paper or Premium Laser
Bond Paper for best results.

m  Paper only. Do not load transparencies.

Note

Load only laser paper in the paper trays. Specialty papers
such as Tektronix Glossy Coated Paper, Tektronix Premium
Cover Paper, envelopes, and Tektronix Laser Labels must be

loaded in the Multi-Purpose Tray.

Do not use transparency in the PAPER tray. This will result in
a Jam-Wrong Media error.

User Guide 21
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Trays

Transparency Tray

0632-02

Use only Tektronix transparencies. See page 9 for supplies
ordering information. For information on Tektronix
transparencies, visit the Tektronix web site:

www.tek.com/Color_Printers/products/supplies/trans/index.html

Install the transparency tray only in the printer’s upper or middle
tray slots. If this tray is installed in the lower tray slot, a front
panel error occurs that stops the print job. The transparency tray
must then be moved to the upper or middle tray slot.

Caution

22

Use of non-Tektronix transparencies can damage printer
components or produce poor image quality.

Do not load paper in the Transparency tray, this will result in
a Jam-Wrong Media error.
Tektronix transparencies

m  Use only Premium or Standard Tektronix transparencies (see
page 9 for supplies ordering information)

m  100-sheet capacity
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Loading Paper or Transparency Tray

Note

Place the side to be printed (for example, letterhead paper)
face-down under the hooks.

1. Push down on the tray’s metal plate until it clicks, locking it in
place.

2. Fan the media to release sheets that are stuck together.

0632-09
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3. Place the media in the tray under the hooks.
Caution

Keep the media level below the indicator on the tray’s
label; otherwise, the printer may jam or be damaged.

m  Letterhead: Load this material face-down under the tray
hooks.

m  Transparencies: Place the Tektronix logo strip face-up under
the transparency tray hooks. Use Tektronix transparencies
only.

MAXIMUM TRAY LEVEL

0632-10

4. Tray capacity:
a. Paper tray 250 sheets

b. Transparency tray 100 sheets
5. Insert the tray.

m  For tray placement guidelines, see page 18.
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Multi-Purpose Tray

Overview

Always use the Multi-Purpose Tray for speciality media; it supports

the following media types:

Supported Media Tray capacity =~ Media thickness
switch
Paper and Paper 2nd Side 100 sheets Thin
75-105 g/m?, (20-28 1b.)
Tektronix Transparency Film 50 sheets Normal
Tektronix Glossy Coated Paper 30 sheets Normal
Heavy paper: 30 sheets Thick
m Cover Stock
m 120-163 g/m?), (40- 60 1b.)
m Index Stock
m 120-163 g/m?, (60- 90 1b.)
m Card Stock
m 120-163 g/m?, (32- 40 1b.)
Tektronix Color Laser Labels 30 sheets Thick
#10 Envelopes 10 envelopes Thick
User Guide 25
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Multi-Purpose Tray

Note

For the best coverage when using laser paper heavier than
105 g/m? (28 1b.) in the Multi-Purpose Tray, select Heavy
Paper as the media type.

If the printer experiences frequent media jams at the
Multi-Purpose Tray, move the Media Thickness Switch to a
thicker setting. If the printer experiences frequent
double-feed errors at the Multi-Purpose Tray, move the
Media Thickness Switch to a thinner setting.

Thin

33100-68

Note

26

The printer prompts you for the paper type and size. If the
wrong media is selected, the printer’s front panel displays a
Jam-Wrong Media message.
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Loading the Multi-Purpose Tray
1. Pull out the slide and adjust the guides for the width of the media.

0632-11

2. Adjust the Media Thickness switch for the media you are using
(see page 25).

&/ &
Thin Normal

User Guide

33100-68
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3. Insert the media:

m  For Tektronix Transparencies place the Tektronix strip
facing down and refer to page 31.

m  For Tektronix Color Laser Labels, place face-up and refer to
page 36.

m  For envelopes, place face-up and refer to page 33.

m  For letterhead, place face-up and refer to page 19.

0632-63

4. The front panel prompts you to select the media type and then the
media size:

Tektronix Transparency

[ Tek Transparency
1y o
// / Letter —» or A4
3 L - —— oK

0632-44
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Tektronix Glossy Coated Paper

Tek Glossy Coated Paper
*—— —— OK

Letter —» or A4
-—— == OK

0632-45

Tektronix Premium Cover Paper

Heavy Paper
*—— —— OK

Letter —» or A4
-*—— —— OK

0632-64

Tektronix Color Laser Label

PE AN TR L

Letter —» or A4
-—— == OK

0632-47

Paper

m  Letterhead

m  Office Laser Paper

m  Standard paper and letterhead 75 - 105 g/m? (20 - 28 1b.)

Paper

- —— OK
Letter > Legal, A4,
- —— OK or Executive

0632-48
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Paper 2nd Side

Standard paper and letterhead 75 - 105 g/m? (20 - 28 1b.)

—» Legal, A4,
or Executive

]
Paper-2nd Side
4 -—— -——» 0K
Letter

2 --- --» OK
Heavy Paper
m  Cover Stock 120-163 g/m? (60 Ib.)
m Index Stock 120-163 g/m2 (90 1b.)
m  Card Stock 120-163 g/m? (40 Ib.)

Heavy Paper

=

- —— —_———

OK

0632-49

Letter

S ~—_]

Envelope #10

- ——

——

OK

—» Legal, A4,
or Executive

Envelope

- —— —_———-

OK

kg

~—L

#10
-

——

OK

0632-51

0632-50

In the Print screen (using a supported driver), select
Multi-Purpose Tray. Send the job to the printer.
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Loading Special Media

Tektronix Transparencies
1. Set the Media Thickness Switch to Normal.

Thin Normal

33100-68

2. Adjust the tray’s guides for the width of your Tektronix
Transparencies.

3. Insert the transparency with the logo strip face-down, entering
the printer first.

PN

— =

AN N N
\\ \\ h AN

N

\\
N
S N
\\\\\ NN

AT

. N
NN
& M

0632-16
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Special Media

4. Fill the Multi-Purpose Tray to the level indicator on the guide
(maximum capacity is 50 sheets).

0236-13

5. At the front panel’s media type prompt, scroll to Tek
Transparency and press OK. Scroll to the media size Letter or A4.

Tek Transparency
- —— OK

Letter —» or A4
-*+—— == OK

0632-44

6. In the application’s Print screen under Tray Selection or Paper
Source, depending on the driver, select the Multi-Purpose Tray

and send the job to the printer.
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Printing #10 Envelopes

1. Prepare each envelope: tuck in the envelope flap.

0632-22

2. Adjust the printer’s media thickness switch to Thick.

33100-69

3. Adjust the printer’s media guides for the width of your envelopes.

sadojanug

0632-24

4. Insert the envelopes (maximum capacity is 10):

a. Short end enters first.
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Envelopes

34

b. Side to be printed is face-up.

c. The edge where you place the stamp enters the printer first
in some applications; make a test print before proceeding.

At the front panel prompt, scroll to Envelope then scroll to #10
and press OK.

Envelope
-—— —— OK

[t e v EE

~_L-
0632-51

In your application create a document with these measurements:

m  Width: (104.1 mm), 4.13 in.

m  Length: (241.3 mm), 9.5 in.

m  Margins: (5 mm), 0.2 in.

Access the Page Setup menu and make these selections:
m  Paper Size: #10 Envelope

m  Orientation: Landscape

In the Print screen, use the supported printer driver, and make
this selection:

m  Paper Source: Multi-Purpose Tray
Send the job to the printer.
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Guidelines for envelope printing:

Caution

Note

User Guide

Never use envelopes with windows or metal clasps; they will
damage the printer. Use envelopes that are at least #10-size.
(4.13 x 9.5 in. /104.8 x 241.3 mm)

Do not print on the envelope’s back side.

Keep unused envelopes in their packaging to avoid the
effects of moisture and dryness, which can affect print
quality and cause wrinkling.

Many applications include a tool for creating an envelope
document. For example, Microsoft Word includes an
Envelopes and Labels feature under the Tools menu. Make
sure that you select Face Up; select the feed method icon
showing the stamp end entering the printer first, with the
image centered; and unselect Clockwise Rotation.

Print a maximum of ten envelopes at a time.

Use envelopes that are at least #10-size
(4.13 x 9.5 in. / 104.1 x 241.3 mm).

No plastic windows or metal clips.
No exposed gummed surfaces.
Single-sided printing only.

Keep unused envelopes in their original packaging.

This printer is not made to handle high-capacity production
envelope printing. Envelopes may wrinkle depending on
weight and stiffness of the envelope.
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Printing on Tektronix Color Laser Labels

At the printer:
1. Adjust the printer’s media thickness switch to Thick.

33100-69

2. Insert the label sheets (maximum capacity is 30 sheets):
a. Side to be printed is face-up.
b. The top of the sheet enters the printer first.

0632-26
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3. Atthe front panel prompt, scroll to Tek Labels and press OK, then
scroll to the media size Letter or A4.

T Tek Labels
A 2.

Letter —» or A4

-—— == OK

0632-47

In the application:

Note

For printing Tektronix Color Laser Labels, you can use
common software settings.

4. If your application has a setting for Avery® labels, use it as a
template. Otherwise, refer to the instructions included with the
labels for margin settings. Use the Avery template for the
Tektronix labels.

Labels
Template Tektronix Labels
Letter:
5160 016-1695-00 (30 per sheet)
5164 016-1696-00 (6 per sheet)
A4:
L7163 016-1688-00 (14 per sheet)
L7165 016-1689-00 (8 per sheet)

5. In the Print screen, use the supported print driver, and select:

m  Paper Source: Multi-Purpose Tray and send the job to the
printer.

User Guide 37
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Labels

Guidelines for printing on labels:

38

Use Tektronix Color Laser Labels.

If any of the labels on a sheet are missing, do not use that
sheet; it may damage printer components.

When selecting Tek Label as the media type, the printer
requires that room temperature be cooler than 27 degrees C
(81 degrees F). If the temperature is above this, the printer
reports an error and stops printing.
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Automatic 2-Sided Printing

Caution

Never put media in the Duplex Unit; the printer reports a
media jam.

Use only laser bond paper for automatic two-sided printing
in the paper tray. Do not use any special media (glossy coated
paper) to print automatic two-sided printing. Two-sided
printing can be done manually; refer to Manual 2-Sided
Printing From the Multi-Purpose Tray on page 43.

Automatic two-sided printing requires that the Lower Tray Assembly
be installed.

1. Make sure that the Duplex Unit is inserted in the printer’s upper
(a) slot.

2. Load 75 - 90 g/m? (20 - 24 1b.) paper in the paper tray.

If you are using pre-printed paper, such as letterhead:

a. Place the first side to be printed face-down.

User Guide 39
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2-sided Prints

b. Place the top of the page under the paper tray’s hooks.
This example shows letterhead paper.

0632-28

3. Insert the paper tray in the printer’s middle (b) or lower (c) tray
slots.
Note
For best results with two-sided printing, use 90 g/m? (24 1b.)
laser paper.
4. Decide on a binding preference (how the page turns) for Step 5:
a. Long-Edge binding or uncheck Bind on top edge.

N\

)

2

0632-29
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b.

Short-Edge binding or check Bind on top edge.

)

2]
>

0632-30

5. In the Print screen, select the 2-Sided Printing option and a
binding preference:

PC Drivers:

Windows 95/ Windows 98

a. From the File menu, select Print.
b. Click Properties.
¢. Click the Setup tab.
d. Click Print on 2-Sides option.
e. Check or uncheck Bind on top edge.
Windows NT4
a. Start/Settings/Printers.
b. Right-mouse-button-click on your printer’s icon.
¢. From the pop-up menu, select Document Defaults.
d. Click the Advanced tab.
e. Under Paper/Output, select Print on Both Sides.
f.  Select Long Side or Short Side.
User Guide
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Macintosh Drivers:

LaserWriter 8.6

b
C
d

From the File menu, select Print.
From the pull-down menu, choose Layout.
Select Print on Both Sides.

Select a binding preference.

2 =)

LaserWriter 8.3.4

a
b.
c
d

From the File menu, select Print.

Click the Options button.

Select 2-Sided Printing.

Select Short-Edge Binding or Long-Edge Binding.

Send the job to the printer.
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Manual 2-Sided Printing From the
Multi-Purpose Tray

Side 1

Caution

Use only laser bond paper for the automatic two-sided
printing in the paper trays. The Multi-Purpose tray should be
used for manual two-sided printing on Tektronix Premium
Color Printing Paper, Tektronix Glossy Coated Paper, or
Heavy Paper. Two-sided printing on specialty media can
shorten component life. For opacity and feed reliability, use
laser paper that is 90 g/m? (24 1b. bond). For best results, do
not use heavy toner coverage on Side 1 of a manual 2-Sided
Print; also, increase the top margin on Side 1 to at least
12mm (or .5 in.).

m  For a multi-page document, print odd-numbered pages for Side 1.
(This selection is application-specific).

1. Set the media thickness switch; refer to page 25 for the correct
setting.
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2. Insert paper with the side to be printed face-up.
This example shows letterhead paper.

==

A)1234567

32564-06

3. In the printer’s front panel, select the media type and size at the

prompt.
Front Panel Media Type
Paper m Standard laser paper, 75-105 g/m?
(20-28 1b.)
Tektronix Glossy Coated m Tektronix Glossy Coated Paper
Paper
Heavy Paper Card stock, 120 - 150 g/m? (32 - 40 1b.)

Cover stock, 120 - 150 g/m? (40 - 54 1b.)
Index stock, 120 - 150 g/m? (60 - 80 1b.)

Heavy laser paper, 120 - 150 g/m?
(32-401b.)

4. In the Print screen (using a supported driver), select
Multi-Purpose Tray as the Paper Source or Tray Selection. Send
the job to the printer.

5. Remove the printed paper from the output tray.
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Side 2

Note

For a multi-page document, print even-numbered pages for
Side 2. (This selection is application-specific).

1. Insert the paper with the blank side face-up.

P= =N

A)1234567 | )

rH

32564-07

2. In the printer’s front panel, select the media type and size at the
prompt.

3. In the Print screen (using a supported driver), select
Multi-Purpose Tray as the Paper Source or Tray Selection. Send
the job to the printer.

4. Remove the printed paper from the output tray.
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Troubleshooting Print Quality

For detailed troubleshooting information, refer to the printer’s
CD-ROM or the Tektronix Color Printer Knowledge Base web site:

www2.tek.com/TekSMART/

If you notice a problem with the quality of your prints, the probable
solution is replacing one of the supplies. Keep in mind this basic
guideline:

m  If the symptom appears in a single color:
Replace the Toner Cartridge.

m  If the symptom appears in all colors:
Replace the Imaging Unit, or Fuser, or Fuser Roll, or
Main Charge Grid, or Transfer Kit.

To diagnose the problem, check these items:

1. Check the front panel for messages on replacing supplies.
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2. From the Help menu, scroll to Supplies Information, press OK
and print the Supplies Page. Use it to diagnose and correct
problems. The Supplies Page contains useful information, such as

the remaining life for supplies.

Pages Remaining: >500 @ 5% coverage

Hi-Capacily Reorder
Standard Reorder:

genta
Pages Remaiing: >600 @ 5% coverage

Hi-Capaciy By
Standarg

Phaser® 750 COLOR PRINTER

Toner Coverage/Page: 13.3%

talled: Sep 1, 1999

0632-56

3. From the front panel Help menu, scroll to Print Quality, press
Menu, scroll to Help Pages, press Menu, and print Diagnostic Test
Pages. (This includes five color pages and one instruction page.)
Examine the prints for symptoms.

0632-60
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Print Quality

Symptom: Problem in one color only

48

1 color has many vertical streaks.

[T

1 color has a light vertical streak.

33100-61

1 color is light or faded.

33100-59

33100-58
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Solution:

1. Adjust the color density.

b.

Press Help, and scroll to Print Quality, press Menu, scroll to
Calibrate Colors. Press Menu, scroll to Adjust Each Color.
Press Menu.

Adjust the density of the color that has problems.

2. Replace the Toner Cartridge of the color that has problems.
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Symptom: Problem in all four colors

m  Streak through all 4 colors.

33100-57

m  Spot in the same place on the page in all 4 colors.

33100-56

m  Random spots appear on every page.

33100-55
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Solution:

1. The choice of media; check the following:
a. Use Tektronix media.
b. Use the correct media tray for the media you are using.

¢.  When using the Multi-Purpose Tray, select the correct media
in the front panel.

2. Run Clean for Smudges. Press Help, scroll to Print Quality. Press
Menu, scroll to Clean for Smudges. Press Ok and press Confirm.

Print about 25 blank pages until the problem disappears.

4. Replace Imaging Unit, or Fuser, or Fuser Roll.
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Symptom: All four colors are solid black

Prints are black (edge to edge).

33100-54

Solution:

Remove then re-insert the Main Charge Grid. If problem persists,
replace the Main Charge Grid.

Symptom: All four colors are extremely faded

33100-53
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Solution:

1.

Choice of media; check the following:

m  Use Tektronix media.
m  Use the correct media tray for the media you are using.

m  When using the Multi-Purpose Tray, select the correct media
in the front panel.

Relative humidity may be too low (below 30 percent relative
humidity).

Refer to Calibrate for Paper in the printer’s front panel and run
this mode:

m  Press Help, scroll to Print Quality, press Menu, scroll to
Calibrate for Paper, press Menu, print the references pages.
Follow the instructions on these pages and adjust the transfer
setting.

Replace imaging unit or transfer kit.
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Symptom: Pieces of print image missing all four
colors

1. Pieces of the printed image are missing and reappear out of place,
approximately 129 mm (5 in.) down the page.

33100-67

2. Media frequently wraps around the Fuser (Jam at C).

Solution:

1. Choice of media; check the following:

m  Use appropriate media in the correct tray location; refer to
page 21 through page 36.

m  Print 10-20 blank pages of plain paper.

m To avoid jams with Tektronix Transparencies, make sure
that the logo strip is loaded face-down for the Multi-Purpose
Tray and face-up for the Transparency tray.

2. IfJam at C, clear the media jam and run the front panel’s Clean for
Smudges cleaning routine (5 blank pages will print to clean the
roller). Press OK and then press Confirm.

3. Replace Fuser.
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Media Jams

Preventing media jams

To reduce the frequency of paper and transparency jams,

use Tektronix media and occasionally clean the rollers. From the
Help Menu, scroll to Print Quality and press OK. Scroll to the
Help Pages and press OK. Scroll to the Paper Tips and print and
read the tips to avoid media jams.

When using the Multi-Purpose Tray, always set the media
thickness switch for the media you are using. See page 25.

If the printer frequently reports Jam at Multi-Purpose, move the
media thickness switch to a thicker setting.

Jam-Wrong Media

1.

Check the trays to make sure that they contain the proper media.

a. Check all PAPER trays and remove all transparencies.
b. Check all TRANSPARENCY trays and remove all paper.

c. If printing from the Multi-Purpose Tray, make sure that the
correct media type is selected from the front panel.

Open the left side door, remove the jammed media. See Jam at A
illustrations.
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Jams

Jam at A
Solution 1

Open the left side door; remove the jammed media.

Solution 2

Remove the media tray; remove the jammed media from inside the
printer.

33100-09
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Jam at B (Lower Tray Assembly Only)
Solution 1

Open the lower left side door and remove the jammed media.

-

33100-10

Solution 2

Remove the selected media tray (middle or lower tray) and remove the
jammed media from inside the printer.

33100-11
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Jam at C

Caution

The Fuser is hot. To avoid personal injury, use caution or
wait for the Fuser to cool before touching it.

1. Remove the Fuser:

a. Open the printer’s front door.

b. To unlock the Fuser, turn the small blue thumbscrew
counterclockwise.

c. Atthe lower left side of the Fuser, press the safety catch and
slide the Fuser out of the printer.

0632-31

2. Remove the Fuser Roll:

a. To unlock the Fuser Roll, press out on the two tabs.
b. Lift the Fuser Roll out of the Fuser and set the roll aside.

0632-32
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3. Torelease the jammed media, turn the Fuser’s large blue knob
clockwise or counterclockwise.

0632-33

4. Remove the jammed media from the Fuser.

0632-34

5. Re-insert the Fuser Roll into the Fuser; re-install the Fuser.

6. The printer automatically prints five blank pages which cleans the
fuser and then resumes the current print job.
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Jam at D

Caution

The Fuser is hot. To avoid personal injury, use caution or
wait for it to cool before touching it.

Solution 1

1. Open the front door.

2. Pull open the access door; the media is visible.

3. Turn the Fuser’s large blue knob counterclockwise.

4. Remove the media.

0632-53

Caution

If the Fuser knob does not turn, do not force it or you may
damage the Fuser. Instead, remove the Fuser and Fuser Roll;
then turn the Fuser knob to release the jammed media.

60 Phaser 750 Color Printer



Solution 2

1. Open the front door and the right side door.

0632-35

2. Turn the Fuser’s large blue knob counterclockwise.

3. Remove the jammed media.

0632-36

User Guide

61



Jam at E

Solution 1

Remove the jammed media from the output tray.

Solution 2

Pull open the access door (above the plastic output tray) and remove
the media.

Note

Open and close the printer’s front door to clear the error
message.
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Jam at Multi-Purpose Tray

1. Remove all media in the Multi-Purpose Tray.

2. Remove the jammed media from the Multi-Purpose Tray.

3. Set the Media Thickness switch for the media you are using
(page 25).

4. Re-insert the media in the Multi-Purpose Tray.

Note

To clear the error message, open and close the printer’s front
door.
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Jam at Duplex Unit

1. Remove the Duplex Unit (it is in the printer’s upper slot).

0632-37

2. Open the Duplex Unit.

0632-38

Note

If paper is not in the Duplex Unit, open the right side door;
paper may be jammed there.
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3. Remove the jammed media.

0632-39

4. Close the Duplex Unit; press down to make sure that it snaps shut
on both sides.

0632-40

5. Re-insert the Duplex Unit into the printer’s upper slot.

0632-41
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Getting Help

Getting Help gives you a comprehensive set of instructions to solve
printer problems. The printer's auto-running CD-ROM guides you to
the various resources available for installing and learning more about
your Tektronix color printer. Use the CD-ROM to install your printer
driver software, view and print user documentation, and watch how-to
videos. Live Internet links on the CD-ROM let you access the Tektronix
Color Connection web site, your single source for color education,
interactive tutorials, free templates and support information.

The front panel Help button:

m  Offers you a suite of tools along with information pages to
help solve printing quality, media feed, supplies, and printer
administration problems.

m  To print the two-page Help Guide: at the printer’s front
panel, press Help, then press Print.

Printer CD-ROM

Advanced Features and Troubleshooting Manual
Supplies instructions

Setup Guide poster

Video help

Networking manuals

Repacking instructions

Printer drivers

Material Safety Data Sheets (MSDS)
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Tektronix web site

www.tek.com/Color_Printers/

Product and supplies information
Downloading printer drivers
Finding your local reseller

Online documentation

TekSMART™ Knowledge Base

www2.tek.com/TekSMART/

Is the same troubleshooting knowledge base used by
Tektronix Customer Support staff

Application issues
Networking issues
Printer errors
Print-quality issues

Troubleshooting

PhaserLink™ Software

www.tek.com/Color_Printers/products/phaserlink.html

View printer status using any web browser

Control printer settings
Link to online documentation via the World Wide Web

Requires network connection via TCP/IP

User Guide
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Color Connection
www.colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of
your color printer:

m Interactive tutorials and helpful tips for using your printer
and favorite software applications
m  Easy access to online technical support.

m  Customized features to meet your individual needs

Other online services

Anonymous ftp server: ftp.tek.com/Color_Printers/

Subscribe to email update notices: www.colorconnection.tektronix.com

U.S. Canada Outside U.S. and Canada

1-800-835-6100 1-800-563-1289

Getting Help

Customer Support Centers

Contact your local
Tektronix office for a list of
local resellers

U. S. and Canada Finland Spain
1-800-835-6100 0800 1 14494 900 97 4499
Australia France Sweden
1800 811 177 05 90 85 41 020 795 177
Austria Germany Switzerland
0 660 5804 0130 82 10 68 155 9493
Belgium Italy The Netherlands
0800 1 5059 1678 77261 06 0221647
Denmark Luxembourg UK

8001 8176 0800 2853 0800 558668
Eastern Europe and Norway

the Middle East 800 11782

+44 1908 681707
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Controlling Color Density

When colors look faded, adjust the toner color density to extend the
life of the components.

Print and use the Color Reference Page

1. In the printer’s front panel, press Help scroll to Print Quality.
Press Menu, scroll to Calibrate Colors. Press Menu, scroll to
Adjust Each Color. Press Menu, and print the Color Reference
Page.

2. Compare the Color Reference Page to the Color Density Samples.
Make a note of the value (=10 to +10) for each color that most
closely matches the samples.

3. Adjust the density for each color: Enter the value noted in Step 2
in the Calibrate Colors menu, under Adjust Each Color.

m  Decrease color density: Press <---.
m Increase color density: Press --->.

4. Reprint the Color Reference Page; check your adjustments.

Calibrate Colors
<D

= & '| Adjust Light/Dark Adjust Each Color I

§

33100-30
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Color Density
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Fonts

Fonts

Resident typefaces (PostScript)

The printer accepts Adobe Type 1 and Type 3 downloadable fonts, TrueType fonts, PCL5,
and a variety of user-defined fonts.

To extend font capability, the printer supports an optional internal IDE hard drive for
storage of additional fonts. Refer to the printer’s user guide, or the Tektronix web site, for
ordering information.

ATM (Adobe Type Manager) software (provided on the printer’s CD-ROM) helps your
computer to display these fonts on screen as they will appear in your prints.

All printer configurations are shipped with 136 resident fonts. To print a sample of the
printer’s fonts, see page 74.

Resident typefaces (PCL5C)

For PCL5C (Printer Command Language) printing, the printer supports Courier, Times,
and Universe typefaces in medium, bold, italic medium, and italic bold. In addition,
there are 46 PCL fonts. The printer port must be set to AutoSelect (which is the default)
for the printer to accept PCL data.
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Fonts

Downloading fonts

Printer-resident fonts are always available for printing. Additional downloadable fonts
can be sent from your computer and stored in the printer’s memory or on a hard disk.
Adding more printer memory expands the number of fonts that can be stored on your
printer.

Downloading fonts saves print time when printing large, or several documents, that use
those fonts.

The printer accepts these (and other) downloadable fonts:

m Type1l
m Type3

[
m Agfa

m  Bitstream
m  Microsoft

m  Apple

m  TrueType (scalable to any point size; look the same on-screen and printed).

Before printing, make sure that the fonts specified in your document are installed in the
printer or are set up correctly. If you request a font in an application that is not resident in

the printer, or is not correctly installed, the text is printed in Courier typeface.

Refer to the printer’s user guide, or the Tektronix web site, for information on ordering a
hard drive for font storage.

72 Phaser 750 Color Printer



Fonts

Downloading fonts from a Macintosh

1. Refer to Downloading files to the printer from a Macintosh on page 95 to locate the
Apple Printer Utility on the printer’s CD-ROM.

Within the Apple Printer Utility, click Open Printer; a dialog box appears.
Click the arrow next to Printer Preferences.

For a list of installed fonts and locations, click the arrow next to Fonts.
Click Add.

Select your font folder, then select the font you want to download.

N o u s Wb

Under Destination, select the download location: either the printer’s memory or an
internal hard disk.

Click Add for one font or click Add All for all fonts in the folder.
9. Click Send; the font(s) appear in the list.

Note

To remove downloaded fonts, click Remove.
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Fonts

Printing a list of resident fonts

From a Macintosh

1.

2.

Refer to Downloading files to the printer from a Macintosh on page 95 to install and
use the Apple Printer Utility.

Within the Apple Printer Utility, from the File menu, select Print Font Samples.

From a PC or workstation

1.

74

Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

For Setup Type, select Custom.

Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.

Refer to Downloading files to the printer from a PC on page 97 for file downloading
instructions.
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Image Smoothing

Image Smoothing

Image Smoothing blends adjacent colors in low-resolution images for smoother color
transitions. For example, use Image Smoothing to improve the appearance of a 72-dpi
image downloaded from the World Wide Web. Image Smoothing is not recommended for
300-dpi or higher images.

There are four ways of selecting Image Smoothing (driver selections override all other
settings):

1. In a supported driver, locate the Image Smoothing option:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.6 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Expert Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Through the printer’s front panel; see the Menu Map for location.
3. Through PhaserLink Printer Management software.

4. Through one of the following PostScript utility files (see Printer Utilities on page 91
for instructions):

Macintosh

m  Image Smoothing On
m  Image Smoothing Off
PC

m  SMOOTHON.PS

m  SMOOTHOFF.PS
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Quick Collate

Quick Collate

Requirements
® DP or DX Feature Set

m Hard drive (internal)

Quick Collate speeds the collation and printing of large print jobs and multiple sets of
documents. The collate function in some software applications repeatedly sends each page
in sequence to the printer until the requested number of copies is printed. With the Quick
Collate option, the job is sent only once and then multiple collated sets are produced by
the printer, allowing much faster processing time.

The number of pages that can be collated at one time depends on the size of the hard disk
installed in the printer.

Note

Make sure that you turn off the collate function in your application, because the
printer’s Quick Collate option is faster than the collate function in software
applications.

In a supported driver, locate the Quick Collate option:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.6 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Advanced Paper Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

Quick Collate and 1st Page Preview

When you use the printer’s Quick Collate option with 1st Page Preview, only the first page
of the first set is printed before pausing for your review.
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Separation Pages

Separation Pages

You can have the printer insert a separation page, or divider page, to separate print jobs,
multiple copies of a single print job, or individual pages of a print job.

There are two selections to make in your printer driver.

1. In a supported driver, locate the Separation Page options:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.6 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Advanced Paper Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Select one of the following for Separation Page:

m  Off: Turns off the Separation Page feature.
m  End of Job: Inserts a separation page between individual print jobs.

m  End of Set: Inserts a separation page between copies, or sets, of a multi-copy
print job.
m  End of Page: Inserts a separation page between every page of a print job.

3. Select one of the following for Separation Page Source:

m  Upper Tray: Takes paper for the separation page from the upper media tray.

m  Middle Tray: Takes paper for the separation page from the middle media tray, if
you have optional paper trays installed.

m  Lower Tray: Takes paper for the separation page from the lower media tray, if
you have optional paper trays installed.
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PANTONE Colors

PANTONE Colors

For the latest information on color libraries, visit the Tektronix web site at:

www.tektronix.com/Color_Printers/

or contact your local Tektronix reseller.

PANTONE Color files for your printer include printer-specific color library files for some
specific applications and a file to print the PANTONE Color sampler chart.

Methods of printing PANTONE Colors

PANTONE Colors from color selection books

In some applications, you can select colors from PANTONE Color selection books. These
colors can be proofed on your Phaser printer before final output on a printing press. For
this method, the printer-specific PANTONE Color files are not required.

1.

From an application, select and apply PANTONE Colors; use individual color values
from a PANTONE Colors selection book.

Print your document; from a supported driver, select the Commercial Press color
correction. (Proof colors may not be completely accurate, but PANTONE Colors will
be printed correctly on a printing press.)

When you are satisfied with the proof, the file can be separated for printing press
plates without adjustment to the file.

Printer-specific PANTONE Colors

Your printer can produce process color simulations of PANTONE Spot Colors.

1.

Print a copy of the PANTONE Color chart. Refer to Printing the PANTONE Color
Chart on page 80.

Within an application, define the desired color in your document by using the
individual CMYK values which appear on the sampler chart.

Print your document. For best results, use the same printer settings for color
correction and print quality, and the same type of paper that you used to print the
PANTONE Color chart.

For final output on a color printing press

For colors to be printed as a process color (no spot colors), follow these steps:

1.
2.

78

Open the application.

Before separating the file for printing press plates, replace the printer’s PANTONE
process Colors with standard PANTONE Colors.
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PANTONE Colors

Installing the PANTONE Color files

From the Web

1. Download the appropriate PANTONE Color file for your printer from the Tektronix
web site:

www.tektronix.com/Color_Printers/

2. Choose a directory location, and extract the file.
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PANTONE Colors

Printing the PANTONE Color Chart

Macintosh

Printing individual pages from Acrobat Reader

1. You will need to install Acrobat Reader if you want to print individual pages from the
PANTONE Color chart. Insert the printer’s CD-ROM in your computer’s drive, go to
the Utilities folder, and install Acrobat Reader onto your computer’s hard disk; follow
on-screen instructions.

2. After Acrobat Reader is installed, locate the Pantone files you downloaded from the
web site. Double-click the desired PDF file.

3. View and print pages from the PDF file. For best results, print on paper.

Note

Print only with the None Color Correction setting; other settings cause
PANTONE Colors to print differently than expected.

Printing the entire chart

80

Use the Apple Printer Utility to download to the printer the desired PANTONE Color
PostScript file, refer to page 91 for instructions. This PostScript file contains
necessary color correction and print quality settings.

For best results and truest color:

m  Print the chart on paper that is similar to the paper that will be used on the
printing press.

m  Turn off two-sided printing when printing the color chart in order to reduce the
effects of color show-through.
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PANTONE Colors

PC

Printing individual pages from Acrobat Reader

1. You will need to install Acrobat Reader if you want to print individual pages from the
PANTONE Color chart. Insert the printer’s CD-ROM in your computer’s drive, go to
the Utility directory, and install Acrobat Reader onto your computer’s hard disk;
follow on-screen instructions.

2. C(Click Start, then Programs, then the program folder you selected; the default is the
printer’s name.

Select the PDF file.
4. View and print pages from the PDF file. For best results, print on paper.

Note

Print only with the None Color Correction setting; other settings cause
PANTONE Colors to print differently than expected.

Printing the entire chart

Print the PANTONE Color chart by sending the PANTONE PostScript file to the printer.
Refer to page 91 for downloading instructions.

m For best results and truest color:

m  Print the chart on paper that is similar to the paper that will be used on the
printing press.

m  Turn off two-sided printing when printing the color chart in order to reduce the
effects of color show-through.
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PhaserPrint Plug-in for Photoshop

The PhaserPrint™ plug-in, included on the printer’s CD-ROM, operates within the
Photoshop application. With PhaserPrint, you can improve image transfer time and gain
easy access to Tektronix printer features and other media features.

PhaserPrint software produces correct output only on supported Tektronix printers.

Note

If you use this plug-in with a printer not listed in the PhaserPrint dialog box, the
image may be placed incorrectly on the page, or colors may look incorrect, or
your file may not print.

Installing the plug-in: Macintosh

Note

The PhaserPrint Plug-in is automatically installed with the software installation
option Easy Install.

Compatibility requirements
m  Photoshop 2.5.1 and higher
m  System 7.0 and higher

Installing the plug-in
1. From the printer’s CD-ROM, run the Installer application. Select Custom Install.

2. Select PhaserPrint plug-in for Photoshop. Click Install; the file is installed in the
Photoshop application’s Plug-ins folder on your computer’s hard disk.
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PhaserPrint Plug-in for Photoshop

Installing the plug-in: Windows

Compatibility requirements

m  Photoshop 4.0 and higher

®m  Windows 95/Windows 98 or Windows NT

m (optional) TCP/IP support requires proper installation of IP networking software and
cards

Installing the plug-in

1. Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

2. For Setup Type, select Custom.

Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Printer Driver
m  Sub-components: Photoshop plug-in

4. Follow the on-screen instructions to complete the installation.
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Using the plug-in

1.

84

If you don’t already have a default printer selected, do the following:

oo

S

Macintosh:
Open the Chooser.

Select a PostScript driver (such as the Apple LaserWriter 8); select your printer.
PhaserPrint software works like a printer driver, and prints to the printer you
selected in the Chooser.

Windows:

Click Start, then Settings, then Printers.
Right-mouse-button-click on your printer’s icon.
In the pop-up menu, select Set as Default.

Within the PhaserPrint software, select your printer and port, as described in
Print using (Windows) on page 86.

Open Photoshop. Open an image file.

From the File menu, select Export. Select PhaserPrint; the PhaserPrint dialog box
appears.

In the Printer Model field, select your printer.

PhaserPrint software supports the following image modes selected from Photoshop’s
Mode menu. If you select a mode not listed here, an error message appears and your
image is not printed.

Bitmap
Grayscale
Indexed Color
RGB Color
CMYK Color
Lab Color
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PhaserPrint Plug-in for Photoshop

Selecting options in the PhaserPrint dialog box

Settings you make in the PhaserPrint plug-in remain in effect until you change them. The
exception is Number of Copies, which defaults to 1 each time you start the plug-in.

Note

You can get information on any of the plug-in’s features or printer-specific
options with the online Help function.

Number of copies

Enter the number of copies to print, from 1 to 1000.

Print using (Macintosh)

The Print using pop-up menu lets you choose between printing an image or saving the
image to disk.

m  AppleTalk: Prints the image to the printer currently selected in the Chooser; the
currently selected printer name is displayed in the Printer model field. If the selected
printer is not a PostScript printer, this option is unavailable (grayed-out).

B PostScript file: Saves an image to disk as a PostScript file. Click Save; a dialog box
lets you choose a new or existing file for saving the PostScript code.

When selected, the File format pop-up menu becomes available. This pop-up menu
has two options: ASCII base-85 and Binary.

m  ASCII base-85: Image data is encoded using an ASCII base-85 filter during file
output, making the resulting PostScript file portable, and downloadable through
interface ports that don’t support binary data. Note that the file may be up to
25% larger.

m  Binary: Image data is output in binary format.
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Print using (Windows)

The Print using pop-up menu lets you choose between printing an image or saving the
image to disk. It has two to four options, depending on your system configuration:

TCP/IP: Available if a TCP/IP stack is installed and running. From Printer model,
choose a printer. Add and delete printers in the list, and edit the printer
configurations. TCP/IP is the fastest printing method; it prints jobs in much less time
than the Local Port or Printer Driver methods, and is the recommended method if it is
available for the printer you are using.

Local Port: Available if you have local ports installed in your PC. From the Port
Name, choose the desired printer port.

Printer Driver: Prints the image through the selected printer driver. From Driver
Name, choose a printer.

PostScript file: Saves an image to disk as a PostScript file. Click Save; a dialog box
lets you choose a new or existing file for saving the PostScript code.

When selected, the File format pop-up menu becomes available. This pop-up menu
has two options: ASCII base-85 and Binary.

m  ASCII base-85: Image data is encoded using an ASCII base-85 filter during file
output, making the resulting PostScript file portable so that it can be downloaded
through interface ports that don’t support binary data. Note that the file may be
up to 25% larger.

m  Binary: Image data is output in binary format. Recommended for network
printing only (not for the parallel port).

Printer model

Displays the currently selected printer.
Lists all printers supported by PhaserPrint software.

When you select your printer model, PhaserPrint displays the correct options for your
printer.

Media size (selection)

Paper sizes are printer-specific; refer to the online Help for your printer’s options.
Before selecting a paper size, select your printer in the Printer model field.

Color Correction
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Color Corrections are not available if Lab is the selected Mode in Photoshop.

If RGB is the selected Mode in Photoshop, the Calibrated RGB option is also
available.
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Media

B The setting remains in effect until you change it.

Quality

B The setting remains in effect until you change it.

Rendering Intent

m  Available in the following cases:

m  If the Mode in Photoshop is RGB, and you select Calibrated RGB as the Color
Correction in PhaserPrint.

m  If the Mode in Photoshop is Lab.

m Calibrated RGB and Lab modes take longer to print than other modes because the
printer must convert CIE colors to RGB or CMYK colors before printing.

Compress Image Data

m  Compresses image data so that less data is sent to the printer or stored in a file.

m  Useful if your network connection is slow, for example, if you are connected to a busy
network or if you are using a parallel port. For fast networks, printing may be faster
without using this option.

B The setting remains in effect until you change it.

Default is On.

Fast preview
Quick print of your image with slightly reduced image quality.
Reflects the printer color correction you selected.

For the fastest printing, use the None color correction option.

Default is Off.
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1st Page Preview

Available only with the printer’s DP or P, and DX Feature Set options.

When sending a multiple-copy print job to the printer through the driver, you can
select 1st Page Preview to preview the first page of the job, and determine if the job is
printing as expected before proceeding with the remainder of the job. This option is
especially useful when printing many copies.

a. Click the 1st Page Preview check box.

b. Check your first print. At the 1st Page Preview message on the printer’s front
panel, select one of the following:

m  Reprint: Reprints the first page, the printer pauses again for the duration of the
selected timeout, or until you press one of the buttons.

m  Cancel: Cancels the print job.
m  Continue: Continues printing the entire job.

At the printer’s front panel, set the 1st Page Preview timeout.

Default is Off.

Image Smoothing

Blends adjacent colors so that color transitions are less noticeable.

Use this option when the image being printed was scanned at a lower resolution than
the printer’s output resolution. For example, printing an image scanned at 72 dpi
using the printer’s Standard print quality mode.

Images printed using Image Smoothing appear with less sharp detail but with
smoother color transitions.

Default is Off.

Stylized representation of the page
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The lower left area of the dialog box displays a stylized representation of the page as it
would look when printed using the current selections in the Scale, Scale to fit,
Printer model, Media size (selection), Landscape orientation, Replicate images,
Center images, and Image separation options. When you change any of these
selections, the representation of the page is redrawn to reflect the new selection.

If Show color preview of image is On, an approximate color image is displayed.
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Scaling an image
B Scale to fit

m  Scales an image to the largest size that fits the image area of the currently
selected page size or orientation.

m  Automatically updates the Scale field value.
B Scale

m  Type the percentage the image should be scaled, from 10 percent to
2000 percent.

m  Use with the Replicate images option to produce multiple copies of an image on
a single page.

m  Alert message: Image clipping will occur.

This message appears in the PhaserPrint dialog box whenever a scaled image will not
fit within the image area of the currently selected page size or orientation option.

Landscape orientation

m  Prints the image horizontally (landscape) on the page. Leave this box unchecked to
print the image vertically (portrait) on the page.

m  Refer to the Stylized representation of the page, in the lower left corner of the dialog
box, to see how your selection will look when printed.

Center images

B Centers the image in the page’s image area.

m  If this box is not checked, the lower left corner of the image is aligned with the lower
left corner of the printable area of the page.

m  If the Center images box is checked and the Replicate images box is checked, the set
of replicated images are centered in the image area of the page.

Replicate images
m  Fills the page’s image area with as many copies of the image as will fit.
m  The size of each replicated image is determined by the setting in the Scale text box.

m  If the size of each replicated image (shown as black rectangles in the stylized
representation of the page) is too small to display, the total image area of the printed
page is shown as a single gray rectangle.

Image size

m  Reflects the dimensions, in inches or millimeters, of the image.

m  Ifthe value in the Scale box is out-of-range, the image dimensions are displayed with
question marks.
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Image separation

Only available if the Replicate images box is checked.

Type an amount, in inches or millimeters (depending on your measurement
standard), to specify the amount of separation between each replicated image.

A larger amount reduces the number of images that can be printed at one time.
Minimum allowed separation value is 0.

Maximum separation value is 100 mm (4 inches).

Default separation value is 3.175 mm (0.125/one-eighth inch).

Valid characters for this field are 0 to 9 and a period (or decimal point).

As you type a value, the stylized representation of the page, and Number of
images and Image layout values are dynamically updated. If the value entered in
the Image separation field is out-of-range, the values in these other fields are
replaced by question marks, and no images are shown in the stylized
representation of the page. If the value is out-of-range, and you click Print or
Save, the following alert is displayed:

The value for Image separation is out of range. It will be replaced with the
closest allowed value.

Number of images

Displays the number of scaled images that will fit in the image area of the currently
selected Media size (selection) and Landscape orientation options.

Number of images reflects the current Image separation value.
If the Replicate images box is not checked, this number is set to 1.

If either Scale or Image separation values are out-of-range, a question mark is
displayed.

Image layout

Shows how the scaled images will fit horizontally and vertically in the image area of
the currently selected Media and Landscape orientation options.

Image layout reflects the current Image separation value.

If the Replicate images box is not checked, this number is set
tolx1.

If either Scale or Image separation values are out-of-range, question marks
are displayed.

Media size (display)

Reflects the dimensions, in inches or millimeters, of the selected media size.

Show color preview of image

Displays an approximate color image, rather than a black box, in the Stylized
representation of the page field.
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Printer Utilities

Printer Utilities

In addition to using the printer’s front panel or the options in a supported driver, the
printer’s utility files offer another method for changing the way the printer operates.
In some cases, a selection can only be made with a utility file.

Utility files control print features such as color correction and enabling or disabling the
Startup Page. However, printer features that are selected from a driver override utility file
settings and front panel settings.

There are three places to locate utility files:

The printer’s CD-ROM

Tektronix’ ftp site

Tektronix’ World Wide Web site

Phaser Hard Drive (if internal IDE Hard Disk is installed)

Files can be downloaded to the printer:

m From a Macintosh

m From aPC
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Printer Utilities

Locating the files on the printer's CD-ROM

Installing the utility files for Macintosh

To install the Apple Printer Utility and the Samplers (color charts):

1. From the printer’s CD-ROM, run the Installer application. Select Easy Install.
2. In the PhaserTools folder on your computer’s hard disk, locate the Samplers (color
charts) and the Apple Printer Utility.

To install the printer’s utility files:

1. On the printer’s CD-ROM, locate the PhaserTools folder, then the Printer Utilities
folder.

2. Copy the Printer Utilities folder, or individual files, to your computer’s hard disk, or
use the files from the CD-ROM.

Installing the files for PC

Locating the printer’s utility files:
1. Insert the printer’s CD-ROM into the CD-ROM drive.

m Ifthe Windows autorun feature is enabled, the CD-ROM launches automatically.
At the opening screen, click Exit.

2. In the taskbar on your screen, click Start, then Programs, then Windows Explorer.
Select the CD-ROM.

3. Locate the utility files on the CD-ROM in the phsrxxx folder inside the utility folder
(where phsrxxx is your printer’s name). Use the files on the CD-ROM or copy the files
to your computer’s hard disk.

Installing the Sampler (color charts and font sampler) files:

1. Insert the printer’s CD-ROM into the CD-ROM drive.

m If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

2. For Setup Type, select Custom.

3. Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

4. Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.
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Locating files on the Tektronix World Wide Web site

Tektronix has a site on the World Wide Web that you can reach from a web browser, at the
following address:

www.tek.com/Color_Printers/

At the Tektronix Color Printer home page, explore options such as customer support
documents and new product information. New and updated information is always being
added, so check the web site frequently.

Use a web browser such as Netscape Navigator, and follow these steps.

1. Start your web browser and enter the following address:

www.tek.com/Color_Printers/support/software.html

2. From the pull-down menus, select your printer, computer, and type of file.

3. Select the files you need; they are downloaded to your computer.
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Printer Utilities

Locating files on the Tektronix FTP server

Utility files included on the printer’s CD-ROM let you set up the printer from UNIX and
VMS workstations to select between media trays, print quality modes, color correction
modes and other features. If you don’t have the means to transfer these files from the
CD-ROM, you can request files from the Tektronix anonymous ftp server.

If you can exchange electronic mail with other Internet sites, you can access the Tektronix
ftp server. From this server you can retrieve driver and utility files and color printer
information either with a web browser or command prompt.

From a web browser:

1.
2.

3.
4.

Start your web browser application.
Type this address:
ftp://ftp.tek.com/

From the pull-down menus, select your printer, computer, and type of file.

Select the files you need; they are downloaded to your computer.

From the command line:

1.
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At the system prompt, type the following: ftp ftp.tek.com
The system responds: Name (ftp.tek.com:<login name>):

Type: anonymous. Press Return.
The system responds: Guest login ok, send your complete e-mail address as
password.

Enter your e-mail address. Press Return.

Change directories to your printer-specific directory:
cd Color_ Printers/UNIX/Phaser 850/utilities

Download the utility files; type: mget *
The system prompts you for each file in the directory, to which you respond y (yes)
or n (no).

Exit the ftp session: type quit or bye; press Return.
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Printer Utilities

Downloading files to the printer from a Macintosh

Using the Apple Printer Utility to download files

All PostScript utility files on the printer’s CD-ROM can be downloaded to the printer with
the Apple Printer Utility.

o1

—
Apple Printer Utility

To download PostScript utility files, follow this procedure:

1.

From the PhaserTools folder on your computer’s hard disk, double-click Apple
Printer Utility.

In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.
m  Under Printers, select your Phaser printer.
m  Click Open Printer.

From the File menu, select Send PostScript File; the Select the PostScript files to
download dialog box appears.

Select the folder location of the PostScript file(s) that you want to download. The
printer’s PostScript utility files are located on the CD-ROM in the Printer Utilities
folder inside the Phaser Tools folder.

Select a utility file. Click Add.
Click Send.

At the prompt Save PostScript output as, you are asked for a file name for saving
printer output. Use the default name given in the edit box or type a new name.
(Printer output includes status messages generated by the printer reporting such
conditions as out of paper.)

Click Save.

If no output is returned by the printer, the Apple Printer Utility displays a dialog box;
click Continue. If output is returned by the printer, you won't see this dialog box.

Check your computer’s hard disk for the message file created by the utility.

To download fonts, see page 72 for additional information.

To print a font sampler, see page 74 for additional information.

To download color sampler charts, see page 110 for additional information.
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Using the Apple Printer Utility to perform other tasks

In addition to downloading PostScript files and fonts, you can use the
Apple Printer Utility to perform the following specialized tasks.

Note

If your printer is connected through a print server, you can only use the Apple
Printer Utility to download PostScript utility files.

Turning on/off the Startup Page
1. Double-click Apple Printer Utility.

2. In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.
m  Under Printers, select your Phaser printer.
m  Click Open Printer.

3. Click the arrow next to Printer Preferences; a list of options appears.
4. C(Click the arrow next to Startup Page.
5. Click one of the following:

m  On: Prints a Startup Page each time the printer is turned on or reset.
m  Off: Stops the Startup Page from automatically printing.
6. Click Send.

Changing the printer’s AppleTalk name
1. Double-click Apple Printer Utility.

2. In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.

m  Under Printers, select your Phaser printer.

m  Click Open Printer.

Click the arrow next to Printer Preferences; a list of options appears.

Click the arrow next to Name.

In the text box, type the new printer name.

Click Send.

o v W
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Downloading files to the printer from a PC

Downloading files from Windows 3.1

1. Select the utility file you want to send to the printer, for example RESET.PS.

2. From the File menu, select Copy; the Copy dialog box appears with the utility file you

selected listed in the From field.

3. In the To field, type the port your printer is connected to. For example, type LPT1:
for a parallel port connection. Click OK.

4, If the Confirm File Replace dialog box appears, click Yes to continue; the file is
downloaded to the printer.

Downloading files from Windows 95 / Windows 98

1. Select the utility file you want to send to the printer, for example RESET.PS.
2. In the taskbar on your screen, click Start, then Programs, then MS-DOS Prompt.

m  Change directory to the location of the utility files.

m  If your printer is connected to the parallel (LPT) port, type the following
command (where xis 1, 2, or 3): COPY RESET.PS LPTx:

Downloading files from Windows NT

1. Select the utility file you want to send to the printer, for example RESET.PS.
2. In the taskbar on your screen, click Start, then Programs, then MS-DOS Prompt.
m  Change directory to the location of the utility files.

m  If your printer is connected to a network, type the following command:
Ipr -S <IP Address> -P PS RESET.PS
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Downloading files if your printer is connected to a Novell Netware
network

This procedure lets you redirect (capture) LPT ports in Novell NetWare. NetWare queues
can be captured from the DOS Prompt or captured directly from Windows. To find out if
an LPT port is already captured, type the following command from the DOS Prompt:
capture show

This will list the current capture data for each virtual port.

Note

If an ad command or file name error occurs, run the command from the file
servers Public directory.

m  For NetWare 3.xx and Netware 4.xx bindery queues:
capture g=[queue_name] l=[port] nb nff nt

where queue_name is the name of the queue to be captured, and port is the virtual
port to capture to, such as LPT3.

Also, nb is no banners, nff is no form feeds, and nt is no tabs.

For example: capture g=phaser_350 1=3 nb nff nt

Note

For NetWare 4.xx NDS queues, the queue name needs to start with a period. For
example: capture g=.phaser_350_g.nds.printers.support 1=2 nb nff nt.

m  For Windows 95 / 98 environments follow these guidelines:
1. From the Details tab of your printer’s driver, select the Capture Printer Port button.
2. Select the appropriate virtual port under the Device field.

m  For bindery queues, enter the path as \\server_name\queue_name and select
OK. For example: \\nw_server\Phaser_350

m  For NDS queues, enter the path as \\Tree\queue_name.context and select OK.
For example: \\Tek\.Phaser_350_Q.nds.printers

m  For Windows 3.1x environments follow these guidelines:
1. From the Windows Control Panel, select Printers.
2. Select the Connect button, then select the Network button.

3. Choose a Port to capture, then locate the appropriate queue.

Note

If the appropriate file server is not listed, click the Attach button and select the
desired file server. Login and click OK. Within the Operation section, check the
box next to the word Permanent, then click Connect. The port should then be
captured.
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Downloading files if your printer is connected through PhaserPort

This procedure lets you create the printer and then redirect the port, turning client #1 into
a print server.

1. On Client #1, create a printer using the LPT1 port.

2
3.
4.
5

b
c.
d

Share the printer to the network.
Install Phaserport and switch the LPT1 port to the Phaserport port.
On client #2, browse the network and install the shared printer.

Open the printer's Properties.

Click Start, select Settings, and then select Printers.
Right-mouse-click on the printer's icon.

In the pop-up dialog box, select Properties.

In the Details tab, click Capture Port and enter the path.

Downloading files if your printer is connected to Windows NT

This procedure lets you redirect (capture) LPT Ports

Under Windows NT print spooler, you create Ports based on their physical location:

However, if you’re at a command prompt (DOS Prompt) and want to print, or copy, a

Local ports = Lpt1 / Lpt2, etc.

IPX Port = \\NW_SERVER\Phaser
Appletalk Ports = WV Net 36:Phaser
TCP/IP Ports = 162.36.62.151:PS or [AUTO]

PostScript file to a port that is a network port, you can do the following:

m TCP/IP Ports:

Ipr -S [printers IP Address] -P [print queue] filename
For xxample: lpr -S 134.62.36.70 -P PS test.ps

m IPX and Appletalk ports require the redefinition of the LPTX port to the network path
through the use of the NET USE command.

NET USE LPT1 \\Server Name\Queue_ Name
For example: NET USE LPT1 \\NW_SERVER\Phaser
or: NET USE LPT2 \\NT_SERVER_NT\Phaser

After redirecting the port using the NET USE command you can use the COPY
command to print the postscript file.

eg. C:\> COPY TEST.PS LPT1:
When finished, end the redirect with the command:
NET USE LPT1 /delete
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Advanced Printing Features for Phaser 750 Printers

Advanced Printing Features for
Phaser 750 Printers

Previewing with 1st Page Preview

When printing multiple pages through the driver (either multiple copies of a single page or
a multiple-page file), select 1st Page Preview to preview the first page of the job before
proceeding with the remainder of the job; this feature is useful when printing a large job.

You can set the timeout in the printer’s front panel (timeout is the amount of time the
printer waits after sending the first page of a file before it continues with the remainder of
the job). The default timeout is 5 minutes.

Requirements
m P, DP or DX Feature Set

B Turn on the feature in the printer driver

Use 1st Page Preview

1. Inasupported driver, select 1st Page Preview:
m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.6 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Expert Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
Under the Properties tab, select the Advanced tab. In the Document Options tab,
select Printer features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Check your first print. At the printer’s front panel 1st Page Preview message, choose
one of these options:

m  Reprint: Reprints the first page, pauses for the duration of timeout or until you
press a button.

m  Cancel: Cancels the print job.
m  Continue: Prints the rest of the print job.
3. Press Select.
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Reset the timeout

1. In the front panel, press Menu. Press the arrow keys until the display reads
Printer Defaults.

2. Press Menu. Scroll to 1st Page Preview.

Change the timeout (the amount of time the printer pauses before completing the
print job):

a. Scroll to 1st Page Preview Timeout. Press Menu.

b. Scroll the pre-set timeouts, then press OK to activate your selection.

Automatic tray switching

When your printer has a Lower Tray Assembly, you can easily run large jobs without
having to replace media often.

1. For automatic tray switching to work properly, load the same type and size media in
all of the printer’s media trays. The media trays must also be of the same type (e.g.,
PAPER). You can also use the Multi-Purpose Tray for automatic tray switching; fill it
with the same media type as the paper trays.

2. Install a tray in each of the printer’s tray slots. If you have the Duplex Unit installed in
the printer’s upper slot, install the media trays in the middle and lower tray slots.

Output Order

This option lets you specify whether your document prints face-up or face-down in the
printer’s output tray. Select the option in one of three ways (driver selections override all
other settings):

m  Through the printer’s front panel in the Printer Defaults menu.

B Inasupported printer driver; Output Order option or Output Face Up option, or Face
Down checkbox.

B Through PhaserLink Printer Management software under Configure Printer Defaults.

Note

The driver or PhaserLink selections override the front panel setting.
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Output Order: Face Up

B Pages are output so that the first page is on the bottom.

m  Depending on the driver you are using, check the Output Face Up box on, or select
Face Up.

Output Order: Face Down

B Pages are output face-down in numerical order.

m  Depending on the driver you are using, uncheck the Output Face Up box, or select
Face Down.

Output Order hints

®m  When printing on transparencies, the printer always prints your document face-up.
m  For prints from the Multi-Purpose Tray, output order is always face-up.
m  If you are using the Quick Collate option — depending on the driver you are

using — select Output Face Down, or uncheck the Output Face Up box.

Note

Some applications send the printing job in the order of back to front, where the
last page of your print job comes out first and the first page comes out last. If this
occurs on your printer, select the face-up box. If only a face-down check box
exists on your printer, make sure this option is unchecked.

Intelligent Ready mode

Intelligent Ready mode is an automated system that monitors the printer’s usage and
warms up the printer when you are most likely to need it. You can set Intelligent Ready
mode with PhaserLink or the printer’s front panel. The front panel only allows you to turn
Intelligent Ready mode On or Off; use PhaserLink to make other settings.

1. In the printer’s front panel, from the Ready prompt; press Menu.
2. Scroll to Configuration; press Menu.

3. Scroll to Intelligent Ready; press Menu.

4. Scroll to On or Off; press OK.
5

To return to normal printer operation; press Exit (the far left button) until Ready is
displayed.
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Adjusting margins

This printer provides a front-panel interface to adjust the page margins:
m  Single-sided print

m  Automatically prints when the printer has one tray only.
m  Duplex (Double-sided print)

m  Requires the Automatic Duplex/Lower Tray Assembly.
m  Duplex Unit must be installed in the upper tray slot.

m  In the front panel’s Printer Defaults menu, Duplex mode must be enabled.

Adjusting margins for a single-sided print

You might want to adjust the margins on a single-sided page if the image area is not
centered on the page. In other words, the margins are not even, relative to the outside edge
of the paper.

0236-63

1. In the front panel’s Printer Settings menu, set the Duplex mode to Disable.
2. Print the Margin Adjust page from the front panel.

a. Press Help.

b. Scroll to Print Quality; and press Menu.

¢. Scroll to Calibrate Margins, press Menu, the display reads:

Calibration Page
<--- --> Print

d. Press Print.

3. Determine if the margins need adjustment: use the page’s top- and left-margin gauges
to note how much the margins are off-center.
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6.

Adjust the left margin:

a. In the Calibrate Margins menu, scroll to Adjust Left Margin. Press Menu.

Adjust Left Margin:+0
< —> OK

b. Enter the amount of adjustment from Step 3 (press <--- or ---> to increase or
decrease the amount); press OK.

Adjust the top margin:

a. Scroll to Adjust Top Margin. Press Menu.

Adjust Top Margin:+0
< -—> OK

b. Enter the amount of adjustment from Step 3 (press <--- or ---> to increase or
decrease the amount); press OK.

Reprint the Calibration Page to confirm the adjustment.

Adjusting margins for a duplex print

You might want to adjust the margins on a two-sided page if the image area of the front
side (shown in blue dashed line) is not aligned with the image area of the second side
(shown in red).
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Adjust the margins for a single-sided print (refer to page 103).

In the front panel’s Printer Settings menu, enable the Duplex mode: select Long-Edge
or Short-Edge.

Print the Margin Adjust page from the front panel.

a. Press Help.
b. Scroll to Print Quality; and press Menu.

¢. Scroll to Calibrate Margins, and press Menu; the display reads:

Calibration Page
<--- --> Print

d. Press Print.
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4. To determine if the margins need adjustment:

a. Hold the page up to the light to see if the margin on the front and back sides
align.

b. Use the page’s top- and left-margin gauges to note how much the alignment is off.
5. Adjust the left margin:

a. In the Calibrate Margins menu, scroll to Adjust Left Margin. Press Menu.

Adjust Left Margin:+0
<--- > OK

b. Enter the amount of adjustment from Step 4 (press <--- or ---> to increase or
decrease the amount); press OK.

6. Adjust the top margin:

a. Scroll to Adjust Top Margin. Press Menu.

Adjust Top Margin:+0
< > OK

b. Enter the amount of adjustment from Step 4 (press <--- or ---> to increase or
decrease the amount); press OK.

7. Reprint the calibration page to confirm the adjustment.
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Adjusting Color Density

Calibrating Colors

When colors look faded, adjust the toner color density to extend the life of the
components.

Print and use the Color Reference Page

1.

In the printer’s front panel press Help, scroll to Print Quality. Press Menu, scroll to
Calibrate Colors, press Menu again and scroll to Adjust each Color. Press Menu
again, the Reference Page front panel message appears, and press Print.

Compare the Color Reference Page to the Color Density Samples in the user guide.
Make a note of the value (—10 to +10) for each color that most closely matches the
samples. Place the Color Reference Page on at least two sheets of clean white
premium laser paper in a well-lighted area and align the Color Density Samples over
the Color Reference Page.

Decide which blocks on the Color Reference Page most closely matches the density of
each color sample. Make a note of the value (-10 to +10) for each color; you will need
this to adjust the colors in the next procedure.

1 2
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Adjust the colors

4.

106

Use the Calibrate Colors menu in the printer’s front panel to adjust the density
according to the values you recorded in the previous procedure. Scroll to Adjust Each
Color and press Menu.

m  The current setting for each color is indicated by an asterisk.

m  To change the setting, press <--- to decrease or ---> to increase the color
adjustment. Refer to the table on the next page for information on these settings.
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5. After changing the density setting for any or all colors, reprint the Color Reference
Page:

m  The dashed line reflects the new settings.

m In this example, the density for each color is set to a different value.

Color Reference Page

Cyan Magenta Yellow Black

+2 7 0 5

+7 +9

° 7 -

9698-18.color
This table shows the selections available in the Calibrate Colors menu.
Calibrate Colors menu selections
Menu item* What it does How it works
Adjust light/dark Lightens or darkens all toner colors. m Press Menu.
<---- --—--> Menu For best results adjust each color
individually in the Adjust each color
menu.
Lighter/Darker:+0 *  Lightens or darkens all toner colors. m To lighten colors, press
<---- > 0K <-- (the number

The current Light/Dark setting reflects
the average value of the four separate

density settings. Each increase adjusts
all four density values up or down the m To darken colors, press

decreases in 1-point
steps); then press OK.

same amount. The available --> (the number
adjustment range is limited so that no increases in 1-point
single color exceeds the +10 value steps); then press OK.
limit.
Adjust each color Controls the color density for each m Press Menu.
<----  ---->  Menu color independently.
Color Reference Page Prints a sample of the current density = Press Print.
<---- ----> Print settings and a range of settings for each
color.
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Calibrate Colors menu selections

Menu item* What it does How it works
Adjust <color>: Enters the menu to calibrate a single m Press Menu.
<---- --—-> Menu color.
Adjust <color>:+0 *  Calibrates the indicated color. m To lighten this color
< > 0K toner, press <-- (the

number decreases in
1-point steps); then press
OK.

m To darken this color
toner, press --> (the
number increases in
1-point steps); then press

OK.
Reset adjustments Resets the color calibration to the m Press Menu; then press
<---- --—--> Menu default settings. Confirm.

* An asterisk (*) indicates the current setting.

Calibrate for Paper

From the front panel:

1. Press Help; and scroll to Print Quality.

2. Press Menu; and scroll to Calibrate for Paper.

3. Press Menu; scroll to Printer Displays Reference Pages, and print this material.
There are eleven reference pages for you to calibrate the specific paper you use. Follow the
instructions on the page that matches your paper and adjust the Transfer Setting.

Use Tektronix brand media for best print quality.

Best results are achieved when relative humidity is below 30 percent.

Print quality may not be improved on some laser paper.

Calibrate for paper changes will only effect Standard and Enhanced print quality
modes from the paper trays, not the Multi-Purpose Tray.
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Color Sampler Charts for
Phaser 750 Printers

Overview

Color sampler charts are colored rectangles with each color’s component values; they help
you select colors in an application that can be reproduced on your printer.

Component values are percentages of each color — CMYK (Cyan, Magenta, Yellow, Black),
RGB (Red, Green, Blue), or HSB (Hue, Saturation, Brightness) — that combine to make a
particular color.
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Color charts

m  Which color chart you print and use depends on how your application selects color.
For information on color selection, refer to the application’s documentation, then
print one or more of the color sampler charts.

m  Each color sampler chart is several pages long; print them in panels and connect them
to form a wall chart or place in a binder for easy reference.

Color sampler chart descriptions

Number of Utility Front PhaserLink
Color sampler chart pages * file panel'
selection
CMYK Sampler Cyan, magenta, yellow, and 18 X X X
black color model
RGB Sampler Red, green, and blue color 12 X X X

model

Hue, saturation, and
brightness color model

HSB Sampler

12 X

* The number of pages will be half with two-sided printing.

Note

To print the PANTONE Color sampler chart, refer to Printing the PANTONE

Color Chart on page 80.
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Printing a color sampler chart from the Phaser 750
printer’s front panel

Note

Use the same color correction and print quality mode to print the chart and to
print from your application. Any other color correction or print quality mode
selections in the driver will cause colors to print differently than expected.

Selecting a color correction and a print quality mode
1. At the Ready message in the printer’s front panel, press Menu.

At the Menu Maps message, scroll to Print Quality, press Menu.
Scroll to Print Quality Modes, press Menu.

BoWN

To change the selected print quality mode:

a. Scroll to More Choices, press OK.

b. Scroll to the selection you want, press OK. The display returns to the Print
Quality Modes level.

Scroll to TekColor Correction, press Menu.
6. To change the selected color correction:

a. Scroll to More Choices, press OK.

b. Scroll to the selection you want, press OK. The display returns to the TekColor
Correction level.

7. Press © until the front panel reads Ready.

Printing a color sampler chart

1. At the Ready message in the printer’s front panel, press Menu.
At the Menu Maps message, scroll to Printer Demo, press Menu.

Scroll to RGB Sampler Prints or CMYK Sampler Prints, press Print.

BoWN

For future reference, write the name of the color correction that you used on the first
page of the chart.

Printing the desired colors from an application

1. Using the color sampler chart that you printed earlier, select the desired colors.

2. From your application, apply the desired colors in your document by entering the
specific CMYK or RGB values as indicated on the sampler chart.

3. Print your document; select the same color correction and print quality mode that you
used to print the color sampler chart.
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Printing the color sampler charts with utility files

From a Macintosh

1.

Refer to Downloading files to the printer from a Macintosh on page 95 to install and
use the Apple Printer Utility. The color sampler charts are also installed during Easy
Install.

Within the Apple Printer Utility, locate the color sampler chart files in the
PhaserTools folder on your computer’s hard disk and download them to the printer to
print.

From a PC or workstation

1.

112

Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

For Setup Type, select Custom.

Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.

Refer to Downloading files to the printer from a PC on page 97 for file downloading
instructions.
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Troubleshooting Phaser 750 Printers

Useful tools

Diagnostic Test Print

Found in the Help Pages menu; five separate pages help you diagnose print quality problems
(for example, if a user-replaceable component needs to be replaced). In the printer’s front
panel press Help, scroll to Print Quality. Press Menu, scroll to Display Help Pages,
press Menu again and scroll to Diagnotic Test Page and press Print.

Color Density Samples and Color Reference Page

Color Density Samples
Included in the User Guide. Provides samples of standard color density, used to
compare to the printer’s current settings that appear on the Color Reference Page.

Color Reference Page

Found in the front panel’s Calibrate Colors menu. Shows the printer’s current density
settings and the ranges for adjustment. Refer to Adjusting Color Density on page 106
for details.

Calibrate for Paper
Refer to Calibrate for Paper on page 108 for details.

Printer CD-ROM

Advanced Features and Troubleshooting Manual
Supplies instructions

Setup Guide poster

Video help

Networking manuals

Repacking instructions

Printer drivers

Material Safety Data Sheets (MSDS)
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Windows driver help system

Install the driver from the printer’s CD-ROM and use the embedded help system.

m  Troubleshooting information
B Access to installed manuals and videos

m Live links to the Tektronix web site

Color Connection
www.colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of your color printer:

Customized support and automatic driver update notification.
Color education with interactive tutorials and helpful hints.
Free templates and promotions.

Online supplies ordering

Online documentation.

PhaserLink™ Software

www.tek.com/Color_Printers/products/phaserlink.html
View printer status using any web browser
Control printer settings

Link to online documentation via the World Wide Web

Receive electronic mail when supplies are low or other printer maintenance is
required

m  Requires network connection via TCP/IP

Tektronix web site

www.tek.com/Color_Printers/
Product and supplies information
Downloading printer drivers

Finding your local reseller

Online documentation
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TekSMART™ Knowledge Base

Troubleshooting Phaser 750 Printers

If the solution to your problem is not found in this Troubleshooting section, refer to the
TekSMART Knowledge Base, www2.tek.com/TekSMART/.

m Is the same troubleshooting knowledge base used by Tektronix Customer Support

staff

Printer errors

Troubleshooting

Application issues

Networking issues

Print-quality issues

Other online services

Anonymous ftp server

ftp.tek.com/Color_Printers/

Subscribe to email update notices

www.colorconnection.tektronix.com

Internal Printer Pages

The printer has several internal help pages available. Refer to the Menu Map for a list and

printing instructions.

Help Pages
Page Description Location
Menu Maps Multiple page map with all At the Ready prompt, press MENU,
functions, help pages, help  which displays Menu Maps and print.
routines from HELP and
MENU front panel buttons.
Help Guide Multiple page help guide to At the Ready prompt, press HELP, which

solve common printer
problems from the HELP
front panel button.

displays Help Guide, and print.

Startup Page

Single page with printer and
configuration information,
that prints after power-ups
unless turned off.

At the Ready prompt, press HELP, and
scroll to About My Printer, press Menu,
and scroll to Startup Page, and print.

Diagnostic Test Pages

Helps to evaluate and
troubleshoot Print-Quality
through test pages.

At the Ready prompt, press HELP, and
scroll to Print-Quality, press Menu
which displays Help Pages, press Menu,
and scroll to Diagnostic Test Pages, press
Print.

Solid Fill Test Page

Helps to troubleshoot
repeated Print-Quality
defects by measuring
distances between defects to
determine the problem.

At the Ready prompt, press HELP, and
scroll to Print-Quality, press Menu,
which displays Help Pages, press Menu,
and scroll to Solid Fill Test Page, press
Print.

Supplies Page

Helps to evaluate the status
of the printer's supplies.

At the Ready prompt, press HELP, scroll
to Supplies Information, press Menu and
scroll to Supplies Page, press Print.
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Help Pages

Page

Description

Location

Print-Quality Tips Page

Tips to use the Tek Color
Corrections and
Print-Quality settings to
optimize your image type.

At the Ready prompt, press HELP, and
scroll to Print-Quality, press Menu,
which displays Help Pages, press Menu,
and scroll to Print-Quality Tips Page,
press Print.

Paper Tips Page Details which paper (or At the Ready prompt, press HELP, scroll
media) types should be used to Print-Quality, press Menu, which
in each tray. displays Help Pages, press Menu, and
scroll to Paper Tips Page, press Print.
Calibrate for Paper Helps you optimize At the Ready prompt, press HELP, scroll

(Reference pages)

Print-Quality on the your
paper and select the best
setting.

to Print-Quality, press Menu, and scroll
to Calibrate for Paper, press Menu,
which displays Reference Pages, press
Print.

Calibrate Colors
(Reference Pages)

Helps you to compensate for
color degradation that
results from supplies
becoming depleted.

At the Ready prompt, press HELP, scroll
to Print Quality, press Menu, and scroll
to Calibrate Colors, press Menu, and
scroll to Adjust each color, press Menu,
which displays Reference Page, press
Print.

Calibrate Margins
(Reference Pages)

Helps you to adjust the top,
left and 2nd side margins.

At the Ready prompt, press HELP, and
scroll to Print-Quality, press Menu, and
scroll to Calibrate Margins, press Menu,
which displays Calibration Page, press
Print.

Configuration Page

Detailed information
regarding the printer's name,
network name and address,
and configuration
information.

At the Ready prompt, press HELP, and
scroll to Printer Administration, press
Menu, which displays Help Pages, press
Menu, which displays Configuration
Page, press Print.

Connection Setup Page

Step-by-step guide for
connecting the printer and
automatically prints on the
first power-up of the printer.

At the Ready prompt, press HELP, scroll
to Printer Administration, press Menu,
which displays Help Pages, press Menu,
and scroll to Connection Setup Page,
press Print.

Event Logs (NetWare
Startup Log, TCP/IP
Startup Log and
Hardware Startup Log)

Captures events that can
help troubleshoot and
isolate network, TCP/IP, and
hardware problems.

At the Ready prompt, press HELP, and
scroll to Printer Administration, press
Menu, and scroll to NetWare Event Logs,
press Menu, and scroll to either NetWare
Event Log, TCP/IP Event Log, or
Hardware Event Log, press Print.

Usage Profile Report

Detailed information about
how the printer is being
used.

At the Ready prompt, press HELP, scroll
to Printer Administration, press Menu,
and scroll to Usage Profile, press Menu,
which displays Usage Profile Report,
press Print.

Printer Demo Pages
(Graphics, Demo,
2-sided, RGB Sampler,
CMYK Sampler)

Shows different detailed
demo capabilities of the
printer.

At the Ready prompt, press MENU,
scroll to Printer Demo, press Menu, and
scroll to any of the demo pages listed,
then press Menu, scroll to Single Print or
Continuous Print, and Print.
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Indicators

Troubleshooting Phaser 750 Printers

Symptom

Possible Causes

Solution

Power indicator is
blinking

m The printer is receiving,
processing or printing a job.

m You have entered the menu in
the front panel.

m Wait for the job to be completed or
cancel the job.

m Exit the menu.

Power indicator is off

The printer is turned off, is not
ready, is disabled, or has
detected an error.

Make sure that the printer is turned on.
Read the front panel message to
determine the printer’s status.

Error indicator is on

Attention is required, but not
immediately. For example,
when the front panel reads
<color>:low.

Correct the condition reported by the
front panel.

Error indicator is
blinking

m The printer is stopped
because it detected a
user-correctable error such as
an open door or a media jam.

m Error occurred that may be
user-correctable.

m Error occurred that is not
user-correctable.

m Correct the condition reported by the
front panel (for example, close the
door or clear the media jam).

m Press the Info/More button to access
information on the error condition.

m Read the front panel message. If the
message includes an error number,
find that number listed in Error codes
on page 148 and follow any
directions there for recovery.

The front panel menu
exits and returns to
Ready without
anyone pressing the
button.

Front-panel timeout: If no
activity occurs in 5 minutes, the
front panel returns to Ready.

Press Menu to re-enter the menu.

Messages

Jam at <Location>

Possible Causes

Solution

Media jam.

m To find the jam: See the front panel message. Also, refer to the
illustration on the inside front door.

m To clear the jam: Refer to the printer’s User Guide.

m Make sure that paper or transparencies are installed correctly
and in the media-specific tray. See the user guide for details

on loading media.

m To prevent a jam: Clean the rollers. See page 156 for details on

cleaning.

Too much media is loaded in
the media tray.

Reduce the amount of media to below the media level indicator

on the media tray label.

Media is wrinkled or curled.

Change the media.

Media is too thick or too thin.

Use recommended media.

For media loaded in the Multi-Purpose Tray, make sure that you
have set the Media Thickness Switch on the printer to
accommodate thick, medium, or thin media.
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Consumables messages

Symptom

Possible Causes

Solution

MPT: <media>

The printer detects media in the
Multi-Purpose Tray and is
waiting for information on the
type of media.

m Scroll through the selections to
choose the media type you have
loaded in the Multi-Purpose Tray.

<color>:low

The indicated color Toner
Cartridge is almost empty.

m Change the Toner Cartridge soon.

Stopped:
replace <color>

Indicated color Toner Cartridge
is empty.

Replace the indicated color Toner
Cartridge now; the printer stops until
you replace the cartridge.

<color> missing

A Toner Cartridge is missing.

Install the indicated color Toner
Cartridge.

Imaging unit:replace

The Imaging Unit is wearing
out.

Replace the Imaging Unit soon.

Imaging unit expired

The Imaging Unit is worn out.

Replace the Imaging Unit now.

Fuser:replace

The Fuser is wearing out.

Replace the Fuser soon.

Fuser expired

The Fuser is worn out.

Replace the Fuser now; although it
continues to function, the print quality
is affected.

Fuser Roll:replace

The Fuser Roll is worn out.

Replace the Fuser Roll now.

Transfer Kit:replace

The Transfer Kit is worn out.

Replace the Transfer Kit.

Main Charge Grid:
replace

Replace the Main Charge Grid soon.

Media Tray: empty

Refill the media tray. If your printer has
a Lower Tray Assembly, the choices
include Upper, Middle, or Lower.

Tek Transparency:
<media type>
<--- --->0K

Media has been loaded in the
Multi-Purpose Tray; select that media
type in the front panel. Press the arrows
to scroll to the appropriate media type;
press OK.

Other messages

Symptom

Possible Causes

Solution

Error ##

An error occurred that may be
user-correctable.

m Press the front panel’s Info button for
more information on the problem.
Press the button labeled More for
suggestions on correcting the
problem.

m Use the information in Error codes
on page 148 to correct the problem. If
the error persists, use the TekSMART
knowledgebase at

www2.tek.com/TekSMARTY/.

Energy Star Mode
Wake Up Menu

The printer is in
energy/conservation mode.

Press the Wake Up button on the front
panel or send a print job to bring the
printer to Ready.
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Maintaining print quality

If you notice a problem with the quality of your prints, the probable solution is replacing
one of the consumable components (Toner Cartridges, Imaging Unit, Fuser, Fuser Roll,
Transfer Kit, or Main Charge Grid).

m  If the printer’s front panel message indicates replacing one or more consumables,
replace it if necessary.

m  To help you diagnose the problem (in the absence of a front panel message), print the
Consumables Page and Service Print 1 from the front panel’s Help Pages menu. Refer
to Front panel messages on page 117 for examples of symptoms, probable causes, and
solutions.

Basic rules for troubleshooting

Symptom appears in one color only

m  Replace the color Toner Cartridge.

Symptom appears in all four colors

m  Replace one of these consumables:
Imaging Unit

Fuser

Fuser Roll

Main Charge Grid

Transfer Kit
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Print quality problems

Note

For print quality problems dealing with color density, refer to Adjusting Color
Density on page 106.

Blue colors look too purple

m  If printed blue colors look too purple, print your document with the Vivid Color color
correction.

If your printed colors do not match your monitor colors, refer to the TekSMART
knowledge base for solutions: www2.tek.com/TekSMART/

1. In the Go to a specific document number field, enter the number 11202 and click Go.

2. A list of solutions for Printed Colors are not Matching the Monitor Colors appears.
Use the PostScript error format to resolve this color problem.

Black-and-white prints instead of color

®m Macintosh users

Make sure that you are using the correct PPD file with the latest Apple
LaserWriter printer driver (version 8.3.4 or higher), which supports color
PostScript.

Make sure that Color/Grayscale is selected in the Print dialog box. Some
applications require special files to print in color. Make sure that these files are
properly installed. For information, refer to the topics on the printer’s CD-ROM
or the Tektronix World Wide Web site.

Make sure that you have not selected Black and White in the Print Quality
dialog box.

m PC users

120

Be sure to use a driver that supports color PostScript.

If you are using Windows, make sure that the Color box in the Options dialog box
is checked. For information on the drivers, refer to the printer’s CD-ROM or
World Wide Web topics.

Make sure that you have not selected Black and White in the Tektronix Printer
Features dialog box.

If you are not using a driver, make sure that you have not set the monochrome
mode selection code; make sure that the front panel is not set for Black and
White.
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Color not uniform or vertical streaks

m  Print shows a single color (a) that is not uniform or print shows a single color (b) with
many vertical streaks (both light and dark) of slightly different density and
non-uniform color.

B Replace the color Toner Cartridge.
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Print appears faded in a single color

B Check the density setting: From the front panel, access the Calibrate Colors menu and
print the Color Reference Page. Compare the settings to the examples on the Color
Density Samples and, if necessary, adjust the density in the front panel. Refer to
page 106.

m  Replace the color Toner Cartridge soon (depending on the complexity of your prints,
you can continue to print up to 100 more pages).

A
e°‘&0

9317-27

A single color has a wide, light, vertical streak

B Replace the color Toner Cartridge.

Print shows small, repeating light or dark spots in a single color

B Replace the color Toner Cartridge.
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A single color shows a light, repeating horizontal line
m To fix the problem:

m  Run 20-30 prints. The impression will disappear with continued time and use.
m To avoid the problem:

m  Occasionally, or a day or two before installing a new Toner Cartridge, rotate the
gear on the end of the cartridge by at least a quarter turn.

Prints are missing fine-line detail

m  Replace the Imaging Unit.

Dark color spots and dark or light streaks appear in all colors

B Replace the Imaging Unit; make sure that the old Imaging Unit is not exposed to light
for more than 3 minutes.

B If a new Imaging Unit does not correct the problem:
m  Put the old Imaging Unit back into the printer.
m  Repack the new Imaging Unit.
m  Replace the Fuser.
Print shows a straight, thin and even, light vertical line in all colors

m  Replace the Imaging Unit.
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Each color bleeds into the color band below it (the most visible is magenta in the yellow
band)

m  Replace the Imaging Unit.

A single white spot appears in approximately the same vertical place on the page
B Run 20-30 blank pages of paper.

m  If the problem persists, replace the Imaging Unit.

A
e°*&0

9317-29

A single, wide, light horizontal band appears in one place on the page (near the top) or
all colors are faded

m  Wait overnight.

m  If print quality has not changed, replace the Imaging Unit.

N
e°"&0

9317-40
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Large light spots

m  Large light spot(s) appear randomly in the print, approximately on the same horizontal
and vertical place or they move vertically from one print to another.

B Print several pages until the artifacts fade.

A\
e°‘&0

9317-45
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A smear in the image repeats at the same location on the page

m  Replace the Imaging Unit.

One or more vertical, dark and even fine lines appear on the print through all colors

m  Replace the Imaging Unit; make sure that the old Imaging Unit is not exposed to light
for more than 3 minutes.

m If a new Imaging Unit does not correct the problem:

m  Put the old Imaging Unit back into the printer.
m  Repack the new Imaging Unit.

m  Replace the Fuser.

Piece of image is missing

m A piece of the printed image is missing and reappears out of place, approximately
129 mm (5 in.) down the page.

m  Verify correct media settings at the Multi-Purpose Tray. Refer to the Phaser 750
Printer User Guide. For best results use Tektronix media.

m  Print 20 pages of blank pages to clean the roller.
m  If you still see the problem: Replace the Fuser Roll.
m  If you still see the problem: Replace the Fuser.
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Vertical scratches

m  The surface of the printed image appears to have vertical scratches (visible by holding
the print at an angle and observing the “shine” of the image).

B At first, the scratches appear only on the printed image; eventually, dark vertical
scratches appear on the unprinted portion of the page.

m  Replace the Fuser (depending on your quality needs, you can continue to print until
the dark vertical lines appear).

Light vertical streaks appear in all colors (most easily visible in yellow)

m  Replace the Main Charge Grid.

Dark and wavy vertical streaks appear in all colors

m  The solution is one of the following:

m  Remove and reinsert the Main Charge Grid.
m  Replace the Main Charge Grid.
m  Replace the Imaging Unit.
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The print is extremely light with a washed out look
B The solution is one of the following:

m  If using the Multi-Purpose Tray, make sure you have selected the correct media
type at the front panel prompt.

Use the Calibrate for paper from the printer’s Help Menu.
Remove and reinsert the Main Charge Grid.

Replace the Main Charge Grid.

Replace the Imaging Unit.

Replace the Transfer Kit.

The entire page prints in black, including the borders

The solution is one of the following:
m  Re-insert the Main Charge Grid.

m  Replace the Main Charge Grid.
m  Replace the Imaging Unit.

Toner spots appear on the back of the media

m  Replace the Transfer Kit.

The page prints in black in the image area only (the borders are white)

m  Turn the printer off and back on again.
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The page is blank

Remove and re-insert the Imaging Unit.

Turn the printer off and back on again.

Horizontal stripes

Thin horizontal stripes or a “weave” pattern appears in a complex image.
Increase the amount of memory.

Print the image at a lower resolution.

Prints have dull, faded colors

If you are using a media tray, make sure that you have loaded the correct media in the
PAPER tray or TRANSPARENCY tray.

If you are using the Multi-Purpose Tray, make sure that you have selected the correct
media type in the printer’s front panel.

Print the Color Reference Page from the front panel’s Calibrate Colors menu. Check
the density settings for each color and compare them to the examples on the Color
Density Samples card. (in the User Guide).

Print the Consumables Page and Diagnotic Test Pages from the front panel’s Help
Pages.

m  Ifall colors are faded on the Test Print, the Imaging Unit may need to be
replaced. Refer to the Percent Remaining gauge for the Imaging Unit on the
Consumables Page.

m  If one color is faded (and you have checked and/or adjusted the density setting
for that color), replace the Toner Cartridge.

Make sure that the Imaging Unit stays covered until immediately before installing it
in the printer. Exposure to light can damage the Imaging Unit and will produce light
streaks or faded prints.

Remove and insert the Toner Cartridges to make sure they are installed correctly.

Make sure that you use a high-quality laser paper: 60 - 90 g/m? (16 - 24 Ib.) paper in
the media trays and 163 g/m? (40 1b.) paper with the Multi-Purpose Tray. For best
results use Tektronix media.

Use only Tektronix transparencies. Tektronix does not guarantee the results of
non-Tektronix transparencies in Tektronix printers.

Try a different color correction mode.
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Image is very faded or pieces of the image are missing; toner on the page is loose

B When using the Multi-Purpose Tray, make sure that you have selected the correct
media type in the printer’s front panel menu.

Streaks or spots

®  Most spots are caused by fingerprints or dust introduced into the printer while
installing the Imaging Unit or loading media.

m  Make sure that the surface where you unpack the Imaging Unit, paper, and
transparencies is free of dust. Keep supplies in a covered area or a closed box.

m  Make sure that the Imaging Unit stays covered until immediately before installing it
in the printer. Exposure to light for more than 3 minutes can damage the Imaging

Unit.

B Do not touch the right side or underside of the Imaging Unit; fingerprints affect print
quality.

m  Make sure that the media is clean.

m  Make sure that you handle the media on the outside edges to avoid fingerprints.

m  To get rid of fingerprint spots, print a few prints (you can print any of the Help Pages
in the front panel menu).

The back of the printed page appears dirty

B Toner particles have contaminated the transfer roller. This can happen if the printed
image is larger than the media (for example, when printing on envelopes). Run
10-20 prints to clean the transfer roller.
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Printing problems

Printer not operating

1.

Make sure that you plugged in the printer and turned it on.
Make sure that you connected the interface cable(s) properly.

Print a Help Page from the front panel to verify that the controller board is functional.
If the Help Page prints correctly, the problem is with your software, driver, or network
setup.

If the Help Page does not print correctly, verify that your print engine is functional by
pressing the Test Print button (the blue pushbutton in the center of the back of the
printer), and holding it down for 3 seconds. If the print engine is functional, it will
print a composite-gray page.

Verify that your printer can communicate:

If you have a Macintosh

m  Make sure that you have the correct PPD file installed and selected and that you
have selected the printer in the Chooser. If the printer’s name does not appear in
the Chooser, your network connection may be faulty.

m  In the Finder, you can use the Print Window command to send a file to the
printer without using an application. If the communication link between your
computer and the printer is working, the printer produces a directory listing of
the active window on the desktop.

If you have a PC
m For Parallel Connections:

1.  AtaDOS prompt, enter: echo show page>lpt1:
(The Ipt could also be a 2 or 3 depending on the port that your printer is
connected through.)

2.  If the communication link between your computer and the printer is
working, the printer ejects a blank page. If this occurs, but you cannot print
from your application or through Windows, make sure that the appropriate
driver is installed and that you have selected the printer correctly.

m For TCP/IP Connections:

1.  AtaDOS prompt, enter: ping TCP\IP
(The TCP/IP is the printer you want to verify is connected to your
machine.
For example, C:\Windows>ping 192.7.34.10)

2.  If the communication link between your computer and the printer is
connected, the printer ejects a blank page. If this occurs, but you cannot
print from your application or through Windows, make sure that the
appropriate driver is installed and that you have selected the printer
correctly.

3.  If you receive a timeout request, refer to the TekSMART knowledge base
for solutions: www2.tek.com/TekSMART/

In the Go to a specific document number field, enter the number 7022 and click Go.
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2. A list of solutions for solving TCP/IP problems dealing with pinging another
computer and timeout issues appears. Most common TCP/IP problems can be
resolved in the article Verifying TCP/IP communications by pinging.

| If the communication link between your computer and the printer is
working, the printer ejects a blank page. If this occurs, but you cannot
print from your application or through Windows, make sure that the
appropriate driver is installed and that you have selected the printer
correctly.

Printer doesn’t appear in the Chooser (Macintosh)

m  Make sure that the printer is turned on and the cables are correctly attached.

m  Check the termination (refer to the documentation for your network adapter or
connector for information on termination).

m If you have changed the printer’s name, make sure that you have given it a unique
name (not the same as any other printer in the zone or on the network).

B Make sure that the correct network is selected in either the Network or AppleTalk
Control Panel.

If the printer does not appear in the Macintosh chooser, refer to the TekSMART knowledge
base for solutions: www2.tek.com/TekSMART/

1. In the Go to a specific document number field, enter the number 2889 and click Go.

2. A list of solutions for connecting The Printer does not Appear in the Chooser’s Select
a PostScript Printer Window Macintosh appears.

3. If you need assistance with connection methods, refer again to the TekSMART

knowledge base. In the Go to a specific document number field, enter 2562 and click
Go.

4. A list of solutions is shown for Connecting a Tektronix Phaser Printer to a Macintosh
Directly via Ethernet.
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Frequent media jams

Use Tektronix media for best results.

Make sure that you use a high-quality laser paper: 60 - 90 g/m? (16 - 24 Ib.) paper in
the media trays and 75 - 150 g/m? (20 - 39 1b.) paper with the Multi-Purpose Tray.

Make sure that the Media Thickness Switch is set correctly for the media installed in
the Multi-Purpose Tray. If the printer has frequent paper jams, set the Media
Thickness Switch to a thicker setting. Refer to the user guide for details on setting
media thickness. If the printer picks multiple sheets of paper at once, set the Media
Thickness Switch to a thinner setting.

If you are using media that is heavier than 90 g/m2 (24 1b.), use the Multi-Purpose
Tray rather than a media tray.

Do not use any media designed for inkjet printers, especially inkjet coated paper and
inkjet transparencies. Inkjet media are coated with a substance that may damage the
Fuser; Tektronix does not furnish service for damage or malfunction caused by the
use of non-Tektronix supplies or consumables. Tektronix coated paper and
transparencies have been specially designed for use with Tektronix Color Laser
Printers.

Use only Tektronix transparencies. Tektronix does not guarantee the results of
non-Tektronix transparencies in Tektronix printers.

Make sure that the media is installed under the hooks at the front of the media tray.

Fan the paper or transparencies before installing them in their respective trays; this is
especially important for transparencies because they tend to stick together.

Do not overfill the media tray, as indicated by the red line on the right side of the tray.
Clean the paper-feed rollers and paper-pick rollers.
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Media frequently wraps around the Fuser

B Use Tektronix media for best results.

B Do not use any media designed for inkjet printers, especially inkjet coated paper and
inkjet transparencies. Inkjet media are coated with a substance that may damage the
Fuser; Tektronix does not furnish service for damage or malfunction caused by the
use of non-Tektronix supplies or consumables. Tektronix coated paper and
transparencies have been specially designed for use with Tektronix Color Laser
Printers.

m  Make sure that you use a high-quality laser paper: 60 - 90 g/m? (16 - 24 1b.) paper in
the media trays and 75 - 150 g/m? (20 - 40 lb. Bond) paper with the Multi-Purpose
Tray.

m  Replace the Fuser Roll.
Off-set images

m  Check your application for correct image sizing.

Cut-off images

m  Check your application for image sizing.

B Make sure that you are using the correct PPD file and have selected the correct
page size.

m  Make sure that the correct size media is in the media tray.
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Image shifts or margins are incorrect (Macintosh)

m  Make sure that you have installed the driver for this printer, or the correct PPD file
onto your Macintosh so that you can select the correct page sizes from the driver.

m If printing on transparencies and your printer has the Automatic Duplex/Lower Tray
Assembly, make sure that the TRANSPARENCY tray is installed in the middle tray slot.
Output is single-sided

m  Make sure that you have installed the Lower Tray Assembly and that the Duplex Unit
is inserted in the upper slot of the printer.

m  Make sure that you have loaded the paper tray with paper and installed it in the
middle or lower slot of the printer.

m  Make sure that you have configured your printer driver to recognize the Lower Tray
Assembly and Duplex Unit. Refer to the printer’s Setup Guide for instructions.

m  Make sure that you have made the selection for duplex printing, using one of these
methods (driver selections override other settings):

m  Front Panel: Under Duplex in the Printer Defaults menu.

m  Print screen: Using a supported driver, select Print on Both Sides or 2-Sided
Printing.
Frequent jams at the Duplex Unit
m  Use only laser paper.
m  Laser paper must be between 75 - 90 g/m? (20 - 24 1b.) in weight.
m  Clean the rollers inside the Duplex Unit with 90 percent isopropyl alcohol.

Margins on the first side and second side of a duplex print are not aligned

B Adjust the margins using the front panel Margin Adjust menu. Instructions are
included in this menu.

Second side of a duplex print is upside-down

m  Select the correct method for binding preference in the front panel or the Print screen.

m  Long-edge binding: Page turns on the long side, regardless of image orientation.

m  Short-edge binding: Page turns on the short side, regardless of image
orientation.

m  Refer to the user guide for detailed instructions.
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Print quality hints

To ensure the best print quality and the most reliable printer operation, follow these
simple guidelines:

136

Use high-quality paper and only Tektronix transparencies and glossy coated paper.

Do not use any media designed for inkjet printers, especially inkjet coated paper and
inkjet transparencies. Inkjet media are coated with a substance that may damage the
Fuser; Tektronix does not furnish warranty service for damage or malfunction caused
by the use of non-Tektronix supplies or consumables. Tektronix coated paper and
transparencies have been specially designed for use with Tektronix Color Laser
Printers.

Double-sided printing and specialty media will require more frequent cleaning of the
rollers and will reduce the average life of the consumables.

Auto-duplex only with laser bond paper that is 75 - 90 g/m? (20 - 24 Ib.). Do not use
paper that is lighter than 75 g/m? (20 1b.); it is not opaque enough for acceptable
duplex prints.

Use only laser paper for automatic double-sided printing with the Duplex Unit.

Keep the Imaging Unit’s light exposure to a minimum — less than 90 seconds of
artificial light and no exposure to sunlight — or you may damage the unit:

m  When installing a new Imaging Unit, keep the protective plastic sheet on until
immediately before inserting the unit.

m If, when installing the Imaging Unit, you also need to install other components,
install the Imaging Unit last to minimize its light exposure.

m  When changing a Toner Cartridge or clearing a media jam, make sure that you
close the printer’s right side door quickly to avoid any light exposure to the
Imaging Unit.

m Do not leave the printer’s front door open for extended periods of time (for
example, several hours).

m Do not touch the underside or the right side of the Imaging Unit; fingerprints may
appear on your output.
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Media hints

Use high-grade media. For best reliability and image-quality, always use Tektronix media.
Refer to the printer’s User Guide for ordering information. Do not use media designed for
inkjet printers; it may damage the Fuser.

Media handling

m  Make sure that the media is dust-free. Dust and dirt can result in poor print quality.
m  Handle media with both hands at the edges to avoid creases and fingerprints.

m  Store media in the original, dust-free package in the same environmental conditions
as the printer.

Double-sided printing
®m  Automatic Duplex. Use laser paper that is between 75 - 90 g/m? (20 - 24 Ib. bond) for
opacity and feed reliability.

B Manual Duplex with the Multi-Purpose tray. Depending on the stiffness and
smoothness of your laser paper, the printer handles paper up to 105 g/m? (28 1b.
bond). Buy a small amount first and try it.

B Manual Duplex with specialty media. For two-sided printing on specialty media
(card stock and Tektronix glossy coated paper), only use the Multi-Purpose Tray. This
is intended for occasional use only.

®  Duplex printing can reduce the life of the printer’s components and may require more
frequent printer cleaning.

If your printer has an Automatic Duplex/Lower Tray Assembly
installed

m  Always place the Duplex Unit into the printer’s upper slot.

m Insert the TRANSPARENCY tray in the printer’s middle tray slot.

m  Place the most frequently used paper in the PAPER tray and insert the tray in the
printer’s lower tray slot.

Specialty media

B Always load specialty media (envelopes, Tektronix Laser Labels, Tektronix Glossy
Coated Paper, Tektronix Premium Cover Paper, and heavy paper) in the
Multi-Purpose Tray.

B Always set the Media Thickness Switch according to the media being used. Refer to
the Phaser 750 User Guide for instructions.

m  When printing labels or envelopes, make sure that you use only the recommended
types.

B Printing on specialty media can reduce the life of the printer’s components and may
require more frequent printer cleaning.
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Improving print speed

Print speed depends on the following criteria:

m  port speed
m  print time

m  driver settings

Relative Port Speed

The fastest ports, in order, are those listed here:

1. Ethernet

2. Token Ring
3. USB port

4, Parallel port

Fastest Print Time

The total print time depends on the following:

Image Complexity

Image Size

Type of port used and network traffic
Printer’s memory configuration
Print/quality mode selected
Color/correction mode selected

If image smoothing is activated

Number of non-resident fonts used
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Driver Settings

Changing the data format used by the driver affects print speed in different operating
systems:
m  Macintosh: the driver defaults to binary data. This is recommended.

B Windows 95/Windows 98: Under the Set Up tab, click Expert Options, then click
PostScript. Check Printer Properties. Put a check in the Use Automatic Data
Format box. This selects the correct data format for the connection method.

m  Windows NT 4.x: In Printer Properties, click the Device Settings tab. Locate the
Output Protocol and type Binary for network connections. If connected via
parallel, change from ASCII to BCP.

m  Windows 2000: Under the Tektronix Features tab, which is available from the
File Print Dialog or Print Manager Printer Properties, check Printer Properties.

If printing is slow, refer to the TekSMART knowledge base for solutions:
www2.tek.com/TekSMART/

1. In the Go to a specific document number field, enter the number 37185 and click Go.

2. A solution for Slow Printing, Print Time Too Long is resolved in the article, Items to
Check for Slow Printing Issues.
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Printed colors are not what you expect

The printed colors do not match your monitor:
m  Select another Color Correction option in a supported driver and print the image
again.

m If you use a non-supported driver and share the printer on a network, the printer’s
default color correction may have been changed.

m  If you use the driver’s Use Printer Setting option and printed colors are not what you
expected, check the following:

m  Check the printer’s color density settings in the front panel Calibrate Colors
menu. You may need to adjust one or all of the colors. Refer to Adjusting Color
Density on page 106 for details.

m  Print quality varies for different types of paper. To optimize print quality for the
paper you use, refer to Calibrate for Paper on page 108 for details.

m A selection may have been made in the front panel’s TekColor Correction menu.
m A color correction utility file may have been downloaded to the printer.

B Monitors versus Printers

m  Monitors and printers reproduce colors differently:

n Display colors on a monitor are formed from additive colors, Red, Green,
and Blue, with emitted light.
[ Printed colors are formed with subtractive colors, Cyan, Magenta, Yellow,

and Black, with reflected light.
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m  The inherent difference between these methods of color reproduction can cause
discrepancy when you compare this to the printed output from your monitor. For
example, combining the additive colors, Red, Green, and Blue, yields white.

Combining the subtractive primaries, Cyan, Magenta, and Yellow, yields black.
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This concept is known as a what you see is what you get (WYSIWYG) problem.
What you actually see on your monitor is not really what you get from the
printer. The monitor is able to reproduce millions of colors using RGB in 256
intensities. Printers use CMYK with the same relative saturation to reproduce
significantly fewer colors. The effect is that monitors display colors outside the
printer’s gamut.

Wide RGB Gamut

Standard RGB Gamut

CMYK Gamut

~

This primarily happens with blue colors, although other colors can be affected.
The difference in color reproduction combined with gamut disparities can cause
printed output that does not match the monitor.

The easiest solution involves changing the TekColor Corrections. For example, if
you want to match the printed colors to the monitor, use the sSRGB Display color
correction.

The most accurate approach is to use the RGB color charts which ship with the
printer. These color charts represent which colors from the RGB gamut the
printer is capable of reproducing. Each color from the chart has corresponding
values for Red, Green, and Blue. Using these values in the application allows
exact color matching.

For further information on color matching, go to the TekSMART knowledge base:
www2.tek.com/TekSMART/

1. In the Go to a specific document number field, enter the number 11202 and
click Go.

2. A database with current information for Printed Colors are not Matching the
Monitor Colors appears on your screen.

Phaser 750 Color Printer


http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+750&PAGE=Color&PgName=TekSmart" target="_blank

Troubleshooting Phaser 750 Printers

Printing PANTONE Colors

If printer-specific PANTONE Colors are not printing as expected, make sure that you are
printing without any color corrections selected. Refer to PANTONE Colors on page 78 for
more information.

There are many variables in process reproduction of colors generated by your printer, any
one of which may affect the quality of the PANTONE Color simulation, including:

Type of media used
Print quality mode selected
Effective final resolution

Dot structure/halftones

Density of the toner colors

Using the Tektronix halftone screens

Tektronix halftone screens are designed for Tektronix printers, and improve print quality
over application-set halftone screens. The Setscreen Off (SCRENOFF.PS) utility file
redefines some PostScript operators, such as the setscreen, setcolorscreen and sethalftone.
When downloaded to the printer, this file prevents applications from overriding the
Tektronix proprietary halftone screens.

Macintosh file names PC file names
Setscreen On SCREENON.PS
Setscreen Off SCRENOFF.PS

Apple Printer Utility

Refer to Printer Utilities on page 91 for instructions on using these files.

If you have any problems with halftone screens, refer to the TekSMART knowledge base
for solutions: www2.tek.com/TekSMART/

1. Inthe Go to a specific document number field, enter the number 7998 and click Go.

2. A solution for Forcing Halftone Screens / Setscreen Patch appears. Most common
halftone screen problems are covered in this material.
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Selecting page sizes in Windows applications

In some Windows applications, you can select printer page sizes in a Print Setup dialog
box accessed from the File menu. If you use a Print Setup dialog box to select the printer
from your application, some page sizes may not be visible in the list.

If the printer page size you want to use is not visible in the list, do the following:

Windows 3.1

1. From the Main window, open the Control Panel and double-click the Printers icon.

2. In the Printers dialog box, select your printer in the list.

3. Click the Setup button.

4. In the Setup dialog box, select the page size you want and click OK.

5. Return to your application. If you open the Print Setup dialog box again from within
your application, the page/size selection may be blank. The page size you just
selected in the driver is still selected, it is just not visible in the list.

6. Print as usual.

Note

If you open the Print Setup dialog box from within an application, and the page
size selection is blank, the blank represents the page size last selected from the
printer driver through the Control Panel. You can leave the page size selection
blank and print as usual, or you can select a page size from the list.

Windows 95

1. In the taskbar on your screen, click the Start icon; a menu appears.

2. Move the cursor over Settings; another menu appears.

3. In the menu, click Printers; the Printers window appears.

4. In the Printers window, select your printer’s icon. From the File menu, select
Properties.

5. Click the Setup tab.

Choose a paper size, and click OK.
Return to your application.
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Fonts printing incorrectly from Windows

If fonts are printing incorrectly from Windows, make sure that you installed the correct
printer with the supported driver and PostScript printer description file (ppd).

If you are not sure which printer configuration you have, look at the front panel display.

Front Panel Displays PostScript printer description file (ppd)
750N Tektronix Phaser 750N

750P Tektronix Phaser 750P

750DP Tektronix Phaser 750DP

750DX Tektronix Phaser 750DX

Sharing the printer on a network

Driver, utility files, and front panel interactions

If your printer is shared on a network, you can affect prints made by others when you
download a utility file or change the printer’s default settings using the printer’s front
panel menus or PhaserLink Printer Management interface.

®m  When you print from a supported driver with any print feature selection except Use
Printer Setting, the driver selection overrides front panel selections or downloaded
utility files for prints made from the driver.

B When you print from a supported driver with the Use Printer Setting option, your
images are printed with either a previously downloaded utility file or the default front
panel menu selections.

B When you print from a non-supported driver, your images are printed with either a
previously downloaded utility file or the default front panel menu selections.

m  Ifthe colors on your prints are not what you expected, and your system administrator
has disabled some of the printer’s front panel menus, use one of these methods to
determine what settings are in effect:

m  Ask your system administrator whether a utility file has been downloaded to the
printer.

m  Print the Configuration Page from the front panel Help Pages menu to see the
current color correction selection.

m  Use PhaserLink Printer Management software to view the current printer
defaults.

If the Apple Printer Utility does not work (AppleTalk)

If your printer is connected through a print server, you can only use the Apple Printer
Utility to download PostScript utility files.

Advanced Features and Troubleshooting Manual 145



Troubleshooting Phaser 750 Printers

Startup Page prints even though it is disabled

If the printer detects a non-fatal error at power-up (for example, faulty printer ports and
some memory failures), the Startup Page prints, even if you have disabled it. In this case,
the page contains one or more of the error messages listed in the following table.
Depending on your needs, you may not need to call for service immediately.

Error messages on the Startup Page

Message Description

Parallel Port failed The named port is not working. The other ports can still
1/O Card failed be used.

DRAM SIMM x failed One of the memory SIMMs is not working. In this message,

x indicates the number of the SIMM that failed. Since the
printer’s base memory is still working, the printer can still
be used, but throughput may suffer.

PostScript printing errors

If your printer reports a PostScript error when printing from Adobe PageMaker, Adobe
FreeHand, QuarkXPress, or Canvas, you may be using an older or incorrect version of the
PostScript Printer Description File (PPD). Refer to the printer’s Setup Guide for
instructions on installing printer description files.

1. Use the most current printer description file. To determine the date of the file you are
using, do the following:

Macintosh users:

m  Select a printer description file.

m  From the File menu, choose Get Info. Make a note of the file’s version date.
Windows 3.1 users:

m In the File Manager, check a printer description file’s creation date.

m  Make a note of the file’s version date.

Windows 95 users:

m  In the Windows Explorer, check a printer description file’s creation date.

m  Make a note of the file’s version date.

2. Check the Tektronix web site listed below to see if the printer description files you
have are the most recent. If the files are not recent, download newer files from the
web: www.tek.com/Color_Printers/

If the printer displays PostScript printing errors, refer to the TekSMART knowledge base
for solutions: www2.tek.com/TekSMART/

1. In the Go to a specific document number field, enter the number 35441 and click Ge.

2. A list of solutions for PostScript errors appears. Most common PostScript error
problems are resolved in the article, General Troubleshooting Guide for PostScript
Errors.
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Enabling the PostScript error report

The error handling utility helps diagnose problems when a job doesn’t print; it provides a
PostScript error-handling function to help determine the cause of some PostScript printing
problems. When the error handler is enabled, PostScript errors and other status
information are printed. This utility is useful for debugging PostScript code.

1.
2.

8.

In the printer’s front panel, press Help.

Press <---- or ----> until the front panel displays this message:
Printer Administration
<= e > Menu
Press Menu.
Scroll to this message:
Post Script Error Info
<= e > Menu
Press Menu; this message appears:
On or Off *

< - > Menu

The * indicates the current selection; disabled is the factory default.
Scroll to On.

Press Ok.
Press © until the front panel reads Ready.

After turning on the error handler, resend the print job; the printer produces an error page.

Note

Windows 95/Windows 98 Microsoft Driver users: The Windows error handler
overrides the front panel error handler. To use the front panel error handler, you
must disable the Windows error handler as well as enable the front panel error
handler. Go to the Windows PostScript tab and uncheck the box Print PS Error
Info.

Windows NT does not have an error handler.

Windows 95/Windows 98 Tek Adobe Driver uses the printer error handler.

Advanced Features and Troubleshooting Manual 147



Troubleshooting Phaser 750 Printers

Error codes

If the printer’s front panel displays a message Error XX, find the error code in this table
and follow the instructions for resolving the problem. If problems persist, check the
Tektronix web site www2.tek.com/TekSMARTY/ or contact service.

Error

User Corrective Action

Error 01

Remove and re-install the black Toner Cartridge, then turn the printer off and
on.

Replace the black Toner Cartridge, then turn the printer off and on.

Error 02

Remove and re-install the cyan Toner Cartridge, then turn the printer off and
on.

Replace the cyan Toner Cartridge, then turn the printer off and on.

Error 03

Remove and re-install the magenta Toner Cartridge, then turn the printer off
and on.

Replace the magenta Toner Cartridge, then turn the printer off and on.

Error 04

Remove and re-install the yellow Toner Cartridge, then turn the printer off and
on.

Replace the yellow Toner Cartridge, then turn the printer off and on.

Error 05, 10,
11, 12, and 13

Turn the printer power off, then on.

Error 20

Remove and re-install the Imaging Unit (make sure that Imaging Unit is locked
in place). Turn the printer off, then on.

Remove and re-install the Main Charge Grid. Turn the printer off, then on.
Remove and re-install the Transfer Kit. Turn the printer off, then on.

Remove and re-install each of the Toner Cartridges. Turn the printer off, then
on.

Replace the Main Charge Grid. Turn the printer off, then on.

Replace the Imaging Unit (make sure that Imaging Unit is locked in place). Turn
the printer off, then on.

Replace the Transfer Kit. Turn the printer off, then on.
Replace the Toner Cartridges. Turn the printer off, then on.

Error 21, 22,
30, and 32

Remove and re-install the Imaging Unit (make sure that Imaging Unit is locked
in place). Turn the printer off, then on.

Replace the Imaging Unit (make sure that Imaging Unit is locked in place). Turn
the printer off, then on.

If a problem persists for Error 30, clean the sensor. See page 156.

Error 33

Check for jammed paper throughout the paper path (especially in paper feeder).

Remove and re-install the paper feeder and Transfer Kit. Turn the printer off,
then on.

Error 40, 41,
42, and 43

Check for jammed paper in the Fuser. Re-install the Fuser. Turn the printer off,
then on.

Make sure that you have the correct Fuser for your local printer power supply:
110-Volt Fuser Part Number 016-1839-00
220-Volt Fuser Part Number 016-1840-00

Replace the Fuser. Turn the printer off, then on.

Error 50, 51

Turn the printer off, then on.
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Error User Corrective Action

Error 52 m Remove the Duplex Unit (if installed).
m Check for paper under the Upper Tray.

m Turn power off, then on.

Error 53 m Open left door and remove any jammed media.

m Tun the printer off, then on.

Error 60 m Remove the media from the Multi-Purpose Tray. Turn the printer off, then on.

m Reinstall the media. Make sure you do not overfill the tray.

Error 61 m Remove and re-install each Toner Cartridge. Turn the printer off, then on.

m Replace each Toner Cartridge. Turn the printer off, then on.

Error 62 m Check for jammed paper throughout the paper path (especially in the paper
feeder and Fuser).

m Remove and re-install the Fuser. Turn the printer off, then on.
m Slide out and re-insert the paper feeder. Turn the printer off, then on.

m Replace the Fuser. Turn the printer off, then on.

Error 63 m Remove and re-install the Imaging Unit. Turn the printer off, then on.

m Replace the Imaging Unit. Turn the printer off, then on.

Error 70, 71, m Turn the printer off, then on.
and 72
Error 73 m Remove and re-install the Imaging Unit. Turn the printer off, then on.

m Replace the Imaging Unit. Turn the printer off, then on.

Error 74 m Remove and re-install the Fuser. Turn the printer off, then on.

m Replace the Fuser. Turn the printer off, then on.

Error 80, 81, m Make sure that all four toner cartridges are installed in the printer.

82, 83, and 84 m Turn the printer off, then on.

Error 01p m Make sure that installed memory DIMM(s) are compatible with printer’s image
through processor board and that they are installed in the proper slot(s).

Error 47p
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Enabling and disabling the Startup Page

Note:

You can choose to have a Startup Page print each time the printer is turned on or
reset, or you can disable the Startup Page. There are three methods for
enabling/disabling the Startup Page:

From PhaserLink Printer Management software
Refer to the PhaserShare Networking Manual for information on using your World Wide
Web browser to access the printer.

From utility files
Download one of the following files from the printer’s CD-ROM or diskettes:

m  Macintosh Use the Apple Printer Utility (refer to page 95 for instructions).
m PC Use utility files STARTPG.PS (enables), NOSTRTPG.PS (disables); refer to

page 97 for downloading instructions.

From the printer’s front panel:

1. Press Menu; the printer displays the following message:

Menu Maps
<---- --—--> Menu

2. Scroll to the following message:

Configuration
<---- ---->  Menu
3. Press Menu.

4. Scroll to the following message:

Startup Page
<---- --->  Menu

Press Menu.

6. Scroll to the following message:

Startup Page:Disabled
< > OK

Press OK.
8. Press © until Ready appears.
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Enabling and disabling the Intelligent Ready feature

When the printer is idle for the time set in the Energy Star front panel menu, the
printer cools down completely. When the printer exits the Energy Star mode, it is
ready to print in about 90 seconds.

The Energy Star default is set to 30 minutes. After 30 minutes of inactivity, the printer
begins a cool-down cycle that requires a 90-second warm-up period before being
ready to use again.

Increasing the Energy Star value from 30 minutes keeps the printer ready for printing
and eliminates the warm-up period. For typical office environments, set the value to
4 hours.

For optimum printing performance and best toner economy, leave the printer turned
on overnight and during weekends.

To increase the timeout value:

1. Press Menu on the front panel; the following message appears:
Menu Maps
<-mm e > Menu
2. Scroll to the Configuration and press Menu; the printer displays the following
message:
Configuration
Cmmmm mees > Menu
3. Scroll to Energy Star Timeout and press Menu; the printer displays the following
message:
Timeout:30 minutes
<-mm e > OK
4. Scroll until the desired setting is reached. For best performance, select 4 hours.
Change the Energy Star Timeout from its default value (30 minutes) to a maximum
value: Press <----.
5. Press OK.
6. Scroll to Intelligent Ready and press Menu; the printer displays the following
message:
Intelligent Ready
Cmmmm mees > Menu
7. Scroll to On and press OK; the printer displays the following:
Intelligent Ready
<-mm e > :0n
OK
8. Press © until Ready appears.
Note

Enabling Intelligent Ready sets the Energy Star Timeout to 4 hours.
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Protected mode for the front panel menu

System administrators can control user access to the front panel menus with the following
utility files (refer to page 97 for instructions on dowloading utility files):

Macintosh utility files:

®m  Menu Short (limits menu access)

B Menu Long (expands menus)

PC utility files:

B MENUSHRT.PS (limits menu access)

B MENULONG.PS (expands menus)

The “short” utility files limit the menu items displayed on the front panel thus preventing
users from changing front panel settings that may affect the prints of other users. Users
instead select printing features — such as color corrections — through their applications
only. In the protected mode, users can still print the Consumables Page, Configuration

Page, Startup Page, and Demonstration Page. The “long” utility files reset the front panel to
display full menus and allow full access to the settings.

If you used the Menu Short or MENUSHRT.PS file to limit the front panel menus, you can
temporarily restore the full menus:

B Press and hold Menu; press ©.
m  Scroll the menus: Press <---- or ---->.

B When you press © again, the front panel returns to the shortened form.
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Enabling and disabling SysStart Job execution

You may load a startup (Sys/Start) file onto an optional internal IDE hard disk. The
Sys/Start job file is similar to an init file: When you turn on the printer, the file

executes — providing that Sys/Start has been enabled through a control file downloaded
to the printer.

You can also control SysStart Job execution from the printer’s front panel Printer Defaults
menu, using the Startup Mode option.

1. Press Menu; and scroll to Configuration.

Configuration

2. Press Menu; and scroll to Startup Mode. Scroll to On and press OK; the printer
displays the following:

Startup Mode
<-mm e > :0n
OK

3. Press © until Ready appears.

Macintosh users

1. From the printer’s CD-ROM, run the Installer application. Select Custom Install.
Select Printer Utilities. From your computer’s hard disk, open the PhaserTools folder.

2. From the PhaserTools folder, double-click Apple Printer Utility.
m  Under AppleTalk Zones, select your printer’s zone.
m  Under Printers, select your printer.
m  Click Open Printer.

3. From the Utilities menu, select Send PostScript File.

4. From the PhaserTools folder, open the Printer Utilities folder; select SysStartjob; click
Add.

5. Click Send.
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PC and workstation users

1. From the printer’s CD-ROM, run setup.exe. Select Custom Install. Select Printer
Utilities. From your computer’s hard disk, open the PHSRTOOL directory. Open the
PHSR750 subdirectory.

2. Select one of the following files:

m SYSTART.PS Enables automatic execution of the
SysStart job.

m NOSYSTRT.PS Disables automatic execution of the
SysStart job.

3. Use one of the following methods to send to the printer the desired file:
m PC users: Use the DOS COPY command.
m  Windows 3.1 users: In the File Manager, use the Copy command.

m  Workstation users: Send a file to the printer as you would any PostScript
file.
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Problems printing on labels

Use only Tektronix Color Laser Labels.

Labels are printed on the wrong side

Make sure that the labels are loaded face up from the Multi-Purpose Tray.

Two-sided printing is not supported for labels.

Make sure that labels are not loaded in the PAPER tray.

Printing labels from Microsoft Word

1.

BoWN

From the Tools menu, select Envelopes and Labels.
In the Envelopes and Labels dialog box, click the Labels tab.
In the Labels dialog, click on the Labels Option icon.

In the Options field, select all of the following, depending on label size:

Letter-size:
a. Printer: Laser and Ink-jet
b. Label Products: Avery Standard

c. Select the label size corresponding to Tektronix label media:

Avery Tektronix label media Part Number

label sizes

5160 Al/Letter (U. S.) 100 sheets / 30 labels per 016-1695-00
8.5 x 11 in. sheet (each 1 x 2-5/8 in.)

5164 Al/Letter (U. S.) 100 sheets / 6 labels per 016-1696-00
8.5 x 11 in. sheet (each 3-1/3 x 4 in.)

Metric-size:
a. Printer: Laser and Ink-jet
b. Label Products: Avery A4 and A5 sizes

¢. Select the label size corresponding to Tektronix label media:

Avery Tektronix label media Part

label sizes Number

L7163 A4 (Metric Letter) 100 sheets / 14 labels per 016-1688-00
210 x 297 mm sheet (each 38.1 x 99.1 mm)

L7165 A4 (Metric Letter) 100 sheets / 8 labels per 016-1689-00
210 x 297 mm sheet (each 67.1 x 99.1 mm)

For a Macintosh: From the File drop-down menu, click Print. In the Print dialog box

General options, for Paper Source, select Multi-Purpose Tray. Click Print.

For a PC: From the File drop-down menu, select Print, click the Properties button.
From the Paper Source drop-down menu, select Multi-Purpose Tray. Click OK, the

Print Dialog box returns. Click OK.
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Cleaning Phaser 750 Printers

Note

When using isopropyl alcohol for cleaning, make sure that the alcohol is at least
90 percent pure. (Never use rubbing alcohol or alcohol with additives; it can
damage the printer.) You can also use pre-soaked alcohol wipes (order number
006-7824-01).

Regularly scheduled cleaning is not necessary for this printer. However, if your printer
experiences frequent media jams, clean these printer parts:

Paper-pick rollers (a)

m  Use a lint-free cloth with 90 percent pure isopropyl alcohol.

Paper-feed rollers (b) on the Lower Tray Assembly

m  Use a lint-free cloth with 90 percent pure isopropyl alcohol.

Duplex Unit

m  Use a lint-free cloth with 90 percent pure isopropyl alcohol.

Sensor

m  Use a dry lint-free cloth.

B Refer to the instructions on page 157.

0236-29
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Cleaning the sensor

If your printer’s front panel displays Error 30, clean the sensor inside the printer.

1. Turn the printer off and open the printer’s front door.
2. Remove the Imaging Unit:
a. Loosen the two thumbscrews by turning them counterclockwise.

b. Turn the lower lever 180 degrees counterclockwise.

c. Slide the Imaging Unit out of the printer and cover it to protect it from light
exposure.

0236-39

3. Use adry, lint-free cloth to wipe the sensor (inside the slot).

9698-64

4. Re-insert the Imaging Unit.

5. Close the printer’s front door and turn on the printer.

Cleaning other rollers

When you clean any of the other rollers in the printer, always use a lint-free cloth.

Caution

Do not clean the transfer roller; alcohol and pressing on the roller can damage the
roller and cause print-quality problems.
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Supplies for Phaser 750 Printers

Average life is based on an average of 5 percent coverage of the printable area for any one
color using laser paper. The frequency of replacement varies, depending on the
complexity of the prints, the percentage of coverage, and the type of media.
Transparencies, glossy coated paper, and other specialty media results in shortened
consumable life. Color printing is based on four images (one each of cyan, magenta,
yellow, and black) per page side.

Coverage Examples
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Toner Cartridges

Order numbers

Average life (percent of coverage)

Standard Toner Cartridges 5 percent/color 5,000 pages (Black)
Cyan 016-1800-00 4,000 pages (CMY)
Magenta 016-1801-00 10 percent/color 2,500 pages (Black)
Yellow 016-1802-00 2,000 pages (CMY)
Black 016-1803-00 20 percent/color 1,250 pages (Black)
1,000 pages (CMY)
High Capacity Toner Cartridges 5 percent/color 12,000 pages (Black)
Cyan 016-1804-00 10,000 pages (CMY)
Magenta  016-1805-00 10 percent/color 6,000 pages (Black)
Yellow 016-1806-00 5,000 pages (CMY)
Black 016-1807-00 20 percent/color 3,000 pages (Black)
2,500 pages (CMY)

Front panel messages

<color> low

m Change the toner soon.

Stopped: Replace <color>

m Change the color toner now.
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Imaging Unit

Order numbers

Average life (percent of coverage)

016-1841-00

5 percent/color 60,000 images
(20 percent/page) (15,000 color pages)

10 percent/color 30,000 images
(40 percent/page) (7,500 color pages)

20 percent/color 15,000 images
(80 percent/page) (3,750 color pages)

Front panel messages

Imaging Unit:replace

m Change the imaging unit soon.

Imaging Unit expired

m Change the imaging unit now.

Fuser

Order numbers

Average life (percent of coverage)

016-1839-00 110 volt
016-1840-00 220 volt

20 percent/page 60,000 pages
40 percent/page 30,000 pages
80 percent/page 15,000 pages

Front panel messages

Fuser:replace

m Change the fuser soon.

Fuser expired

m Change the fuser now.
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Fuser Roll and Cleaning Pad

Order numbers Average life

Standard mode)

Enhanced mode)

016-1843-00 15,000 pages
12,000 pages
8-10,000 pages (Special media usage)

(
(

Front panel messages

Fuser Roll:replace m Change the fuser roll soon.

Stopped: Fuser Roll:replace m Change the fuser roll now.

Transfer Kit

Order numbers Average life

016-1842-00 80,000 pages

Front panel messages

Transfer Kit:replace m Change the transfer kit now.
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Main Charge Grid

\r\
Order numbers Average life
016-1665-00 30,000 images
(7,500 color pages)
Front panel messages
Main Charge Grid:replace m Change the main charge grid now.

Supplies life information

This printer provides several convenient methods for accessing the information you need
on the life of the user-replaceable components. Refer to Using the information on the
Supplies Page on page 163 and Useful tools on page 113 for more detailed information on
accessing and using these tools.

Supplies Page
Print from the Help Pages menu in the front panel.
Usage Profile Report

Provides in-depth information on printer usage:
Supplies used
Tray and media selections

Printer interventions

Analysis of usage rates

For detailed information on the Usage Profile report, refer to Printer Management on the
printer’s CD-ROM or web site. Print from the Help Pages menu in the front panel or set up
automatic email notification.

Status of each supply

Access the Supplies Status menu in the front panel.
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Using the information on the Supplies Page

Using the Supplies Page:

m  Toner life remaining:
m OK: More than 500 pages remaining at 5 percent coverage
m LOW: Less than 500 pages remaining at 5 percent coverage
Percent Remaining gauge for all other supplies
Average Toner Coverage per Image or Page

Date of installation

Illustration of supply locations

Pages Remaiing: >500 @ 5% coverage

Hi-Capacity Reorder:
Standard Reorder

genta

Pages Remaining: >500 @ 5% coverage

Hi-Capacity R
Standar Phaser®750 COLOR PRINTER

0632-56
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Regulatory Information for
Phaser 750 Printers

Canadian EMC (Electromagnetic Compatibility)
regulatory standards

m This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

B Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les
limits applicables aux appareils numériques de la classe B prescrites dans le
Réglement sur le brouillage radioélectrique édicté par le ministere des
Communications du Canada.
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Declaration of conformity

for 220-230 VAC equipment

Tektronix, Inc.

Color Printing and Imaging Division

P.O. Box 1000

Wilsonville, Oregon 97070-1000 U.S.A.

declares, under our sole responsibility, that the products

Phaser 750 printer (2750)

to which this declaration relates, is in conformity with the following standard(s) or other
normative document(s):

Following the provisions of the Low Voltage Directive 73/23/EEC

EN 60950:1992
(IEC 950)

Safety of Information Technology Equipment including Electrical Business

Equipment

Following the provisions of the Electromagnetic Compatibility Directive 89/336/EEC

EN55022:1992
(CISPR 22)

Limits and methods of measurement of radio interference characteristics of
Information technology equipment. Class B.

EN61000-3-2:1995
(IEC61000-3-2)

Part 3: Limits - Section 2: Limits for harmonic current emissions (equipment
input current £ 16A per phase).

EN61000-3-3:1994
(IEC61000-3-3)

Part 3: Limits - Section 3: Limitation of voltage fluctuations and flicker in

low-voltage supply systems for equipment with rated current £ 16A.

EN55024:1997

Information technology equipment — Immunity characteristics
— Limits and methods of measurement.

Immunity Basic Standard Test Specification Performance Level Criteria
Phenomena
Electrostatic EC61000-4-2:1995 10 discharges minimum 6kV Contact A
Discharge each polarity per test 12kV Air A
point
Radiated Rf IEC61000-4-3:1995 80-100 MHz 3V/m, A
field, AM 80 percent
AM @1kHz
Fast Burst IEC61000-4-4:1995 5/50 Tr/Th ns 0.5kV Signal Lines A
Transients 5kHz repetition 1kV AC Mains A
frequency
Line Surge on EC61000-4-5;1995 combination wave; 2.0kV Com. mode A
AC mains Tr=1.2uS, Th=50uS 2.0kV Diff. mode A
Conducted RF,  EC61000-4-6;1996  0.15 to 80 MHz 3V, 80 percent A
AM AM@1kHz
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Immunity Basic Standard Test Specification Performance Level Criteria
Phenomena

Voltage dipsand EC61000-4-11;1994 >95 percent voltage .5 cycles @ 50Hz A
interruptions reduction 25cycles@50Hz A

30 percent voltage 250 cycles @ 50 Hz

reduction

> 95 percent voltage
reduction

This product, if used properly in accordance with the user’s instructions is neither
dangerous for the consumer or the environment.
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FCC Class B device

for 100-120 VAC equipment

The equipment described in this manual generates and uses radio frequency energy. If it is
not installed and used properly in strict accordance with Tektronix’ instructions, it may
cause interference with radio and television reception.

This equipment has been tested and verified to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interferences in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one of more of the following
measures:

m  Reorient or relocate the receiving antenna.
m Increase the separation between the equipment and receiver.

m  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

m  Consult the dealer or an experienced radio/TV technician for help.
Warning

Changes or modifications not expressly approved by Tektronix can affect
emission compliance and could void the user’s authority to operate this product.
To ensure emission compliance, use shielded interface cables.
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Material Safety Data Sheets for
Phaser 750 Printers

Proper management of environmental resources protects the well-being of our employees,
customers, shareholders, and the communities we are a part of worldwide.

Tektronix establishes and maintains sound environmental management practices to
accomplish this goal and to assure compliance with the laws, regulations, and orders of

the responsible governmental authorities wherever Tektronix and its subsidiaries operate.

Tektronix, Incorporated is complying with government regulations by providing Material
Safety Data Sheets for this product.

Color Printing and Imaging Division
Tektronix, Incorporated
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MSDS for Toner

SECTION 1- PRODUCT IDENTIFICATION

Trade Names Tektronix Part Number
Black Toner Cartridge 016-1803-00, 016-1807-00
Cyan Toner Cartridge 016-1800-00, 016-1804-00
Magenta Toner Cartridge 016-1801-00, 016-1805-00
Yellow Toner Cartridge 016-1802-00, 016-1806-00

Product Use: Tektronix Phaser 750 printer.

SECTION 2 - INFORMATION ON INGREDIENTS
Ingredients: Toners are a proprietary blend of resins and pigments, encased in a cartridge.

SECTION 3 - HAZARDS IDENTIFICATION

ROUTES OF EXPOSURE: Toner powders are encased in a cartridge. Minimal exposure through
inhalation or skin contact is expected when used as intended.

POTENTIAL HEALTH EFFECTS: Health effects from this product are expected to be negligible,
when product is used as intended.

Immediate Effects:

Inhalation: Minimum irritation to respiratory tract, as for any non-toxic dust.

Skin: Expected to be low hazard to skin, when used as intended.

Eye: May cause mild irritation.

Ingestion: Not an expected route of exposure.

Chronic Effects: None known or expected.

SIGNS AND SYMPTOMS OF EXPOSURE: Minor irritation to respiratory tract, skin, and eyes.
MEDICAL CONDITIONS AGGRAVATED BY EXPOSURE: None known.

SECTION 4 - FIRST AID MEASURES

INHALATION: Unlikely route of exposure. In the event of exposure, remove person to fresh air.
Seek medical attention if symptoms occur.

EYES: If particles get into eye, flush thoroughly with water. Seek medical attention if symptoms
occur.

SKIN: Wash thoroughly with water. Seek medical attention if symptoms of irritation occur.
INGESTION: Seek medical attention immediately.

SECTION 5 - FIRE FIGHTING MEASURES
FLASH POINT: Not applicable.

FIRE & EXPLOSION HAZARDS: These toners will burn. Like most organic powders, explosive
mixtures can form when powder is dispersed in air.

EXTINGUISHING MEDIA: Use CO2, dry chemical, foam, or water.

FIRE FIGHTING INSTRUCTIONS: Avoid inhalation of smoke. As for any fire, wear protective
clothing and self-contained breathing apparatus.

SECTION 6 - ACCIDENTAL RELEASE MEASURES

SPILL OR LEAK: Toners are encased in a cartridge. However, in case of breakage, toner powders
may be cleaned up with a broom or vacuum. Sweep slowly to minimize dust generation. If a vacuum
is used, the motor must be dust tight. Clean up residue if necessary with soap and water. Wash or
dry clean garments after removing loose toner.

SECTION 7 - HANDLING AND STORAGE
HANDLING: No special precautions
STORAGE: Avoid high temperatures.
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SECTION 8 - EXPOSURE CONTROL - PERSONAL PROTECTION
No special protection indicated when used as intended.

TLV/PEL: Black toner contains carbon black, which has an OSHA Permissible Exposure Limit (PEL)
of 3.5 mg/m3 (milligrams per cubic meter of air), as an 8-hour time-weighted average. The ACGIH
Threshold Limit Value (TLV) is also 3.5 mg/m3.

SECTION 9 - PHYSICAL AND CHEMICAL PROPERTIES
APPEARANCE: Black, blue, red, or yellow powders.
ODOR: None.

SOLUBILITY: Not water soluble.

SECTION 10 - STABILITY AND REACTIVITY

STABILITY: Stable.

INCOMPATIBILITY WITH OTHER MATERIALS: Strong acid or alkaline materials.
HAZARDOUS POLYMERIZATION: Will not occur.

HAZARDOUS DECOMPOSITION PRODUCTS: During a fire, toxic gases may be generated by
thermal decomposition or combustion.

SECTION 11 - TOXICOLOGICAL INFORMATION

TOXICITY: Expected to have low acute oral toxicity, as determined by standard laboratory tests
performed on very similar toners.

CARCINOGENICITY: Not listed by NTP or OSHA. Black toner contains carbon black, which has
been classified by the International Agency for Research on Cancer (IARC) as a class 2B carcinogen,
possibly carcinogenic to humans. However, toners very similar to these have been tested in bacterial
assays for mutagenicity (Ames Test) and were found to be not mutagenic.

SECTION 12 - ECOLOGICAL INFORMATION

No known impact.

SECTION 13 - DISPOSAL CONSIDERATIONS

These products are not a RCRA hazardous waste as specified in 40 CFR 261. Dispose in accordance
with all federal, state, and local regulations.

SECTION 14 - TRANSPORT INFORMATION
DOT: Not regulated.

SECTION 15 - REGULATORY INFORMATION

TSCA: All components of these toners are listed in the Toxic Substances Control Act inventory as
verified by our suppliers.

RCRA: TCLP metals below hazardous waste levels set by EPA.
California Proposition 65: Not regulated.
SARA Extremely Hazardous Substances/313: Not regulated

SECTION 16 - OTHER INFORMATION
Original preparation date: November 1, 1999. JMP

Tektronix, Incorporated

P.O. Box 1000

Environmental, Health & Safety
Mail Stop 60-512

Wilsonville, Oregon 97070

Printer information: 1-800-835-6100
MSDS information: (503) 685-2758
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Environmental Specifications
(Temperature/Humidity/Power)

Operating range: temperature and humidity

The operating range is contained within the temperature/humidity space defined by the
following points:

Celsius:

15 degrees Celsius, 10 percent relative humidity
32 degrees Celsius / 10 percent relative humidity
32 degrees Celsius / 60 percent relative humidity
25.5 degrees Celsius / 80 percent relative humidity
15 degrees Celsius / 80 percent relative humidity

Fahrenheit:

60 degrees Fahrenheit, 10 percent relative humidity
90 degrees Fahrenheit / 10 percent relative humidity
90 degrees Fahrenheit / 60 percent relative humidity
78 degrees Fahrenheit / 80 percent relative humidity
60 degrees Fahrenheit / 80 percent relative humidity

The best print quality is obtained within these limits:
18 degrees to 25.5 degrees Celsius (64 degrees to 78 degrees Fahrenheit), and 30 percent to
80 percent relative humidity

Temperature

Non-operating: 0 degrees Celsius to 40 degrees Celsius (32 degrees Fahrenheit to
104 degrees Fahrenheit)

Storage: (without paper, transparencies, or consumables): —20 degrees Celsius to
+60 degrees Celsius

(—4 degrees Fahrenheit to +140 degrees Fahrenheit)

Humidity
Non-operating: 10 percent to 90 percent relative humidity, non-condensing

Altitude
Operating: 0 to 2,500 m (8,000 ft.).
Non-operating: 0 to 4000 m (13,125 ft.)

Primary voltage ranges
90 - 132 VAC, 110 VAC nominal
198 - 264 VAC, 220 VAC nominal

Frequency range
50 to 60 Hz

Primary fusing

125 VAC, 10 Amps and 8 Amps
250 VAC, 5 Amps and 4 Amps
(Not user-accessible)
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Power Consumption
Meets Energy Star power conservation requirements.

State Average power
Continuous printing 380 W

Idle 115 W

Energy Star 45 W or under

Dimensions of standard unit (without Lower Tray Assembly)
Height: 464 mm (18.3 in.)

Depth: 501 mm (19.7 in.)

Width: 507 mm (20* in.)

*782 mm (30.8 in.) with the output tray
Dimensions of Lower Tray Assembly
Height: 249 mm (9.8 in.)

Depth: 405 mm (16.0 in.)
Width: 447 mm (17.6 in.)
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resetting the timeout 100
Chooser
printer doesn’t appear 132
selecting a driver 131
cleaning 156
CMYK Sampler, Macintosh utility file 112
collating multiple copies 76
color charts
CMYK 110
HSB 110
PANTONE Color 78
printing
from the front panel 111
printing from a Macintosh 112
RGB 110
Color Connection web site 114
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controlling 69, 106
using the Color Density Samples card 69, 106
Color Reference Page
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downloading files to the printer
Apple Printer Utility 95
Macintosh 95
PC 97
Windows 3.1 97
Windows 95 97
downloading fonts 72
E
email notification 68, 115
enabling and disabling the Startup Page 150
energy saving mode 102
Energy Star
changing the timeout value 151
standby mode description 151
Environmental Specifications 171
error codes 148
error handler, PostScript 147
error indicator, troubleshooting 117
Ethernet problems, troubleshooting 132
F
Font Sampler, Macintosh utility file 74
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downloading 72
Macintosh 73
printing a list of resident fonts 74
sampler, printing 74
TrueType 72
FONTS.PS, PC utility file 74
frequency range 171
front panel
Calibrate Colors menu, using 107
Check Print 100
menus 152
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Supplies Page 163
timeout 117
troubleshooting 117
front panel messages
error codes 148
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replace imaging unit 118
replace toners 118
FTP server
accessing 68, 115
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fuser
average life 160
ordering information 160
troubleshooting 118
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ordering information 161
troubleshooting 118
G
getting the best results 143
H
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Help Pages
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Output Order 102
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I
Image Smoothing 75
using with PhaserPrint 88
imaging unit
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L
labels
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cleaning, occasional 156
margins
adjusting a duplex print 104
adjusting a single-sided print 103
Material Safety Data Sheets (MSDS) 168
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media jams
avoiding 133
troubleshooting 117
Menu Long, Macintosh utility file 152
Menu Short, Macintosh utility file 152
MENULONG.PS, PC utility file 152
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MSDS, toner 169
multiple copies, collating 76
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network printing 145
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O
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Output Order 101
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selection books 78
PANTONE Colors, troubleshooting 143
paper
handling 137
picking errors 133
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FONTS.PS 74
MENULONG.PS 152
MENUSHRT.PS 152
NOSYSTRT.PS 154
SYSTART.PS 154
PhaserLink Printer Management Software
brief description 114
PhaserLink Software, description 67
PhaserPrint plug-in
compatibility requirements 82
for Photoshop 82
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selecting options 85
starting the plug-in 84
Photoshop plug-in 82
Plug-in, Adobe Photoshop, using 82
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error handler 147
printing errors 146
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color density 106
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print quality
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print separation pages 77
print speed, improving 138
printer
internal pages 115
printer configuration information 145
printer dimensions 172
printer front panel menus 152
printing on a network
recommendations 145
printing PANTONE Colors 143
problems with color 140
Q
Quick Collate option
overview 76
using with the 1st Page Preview option 76
R
regulatory standards 164
RGB Sampler, Macintosh utility file 112
S
scaling images
using PhaserPrint 89
selecting page sizes in Windows applications 144
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Setscreen 143
slip sheet 77
Specifications
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